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Kata Pengantar 
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dan salam senantiasa tercurahkan kepada junjungan kita Rasulullah SAW, sehingga 
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namun demikian juga tidak mengabaikan teori. 

Untuk itu penggunaan buku ini harus didampingi dengan pengajar. Pengajar 

diharapkan dapat memberikan improvisasi dalam penyampaianya dengan 

menambahkan berbagai contoh kasus nyata, sedemikian hingga mendapatkan 

pengetahuan yang lebih komprehensif terkait dengan materi yang diampuhnya. 

Sepenuhnya kami menyadari bahwa dalam penyusunan buku  ini banyak pihak 

yang telah memberikan bantuannya, untuk itu pada kesempatan ini kami   ingin 

menyampaikan terima kasih.“Tiada gading yang tak retak”, kiranya ungkapan 

itulah yang paling tepat ditunjukkan buat penyusun, karena sebagai manusia 

biasa, pastilah penyusun memiliki keterbatasan dan kekurangan, sehingga karya ini 

masih jauh dari kesempurnaan. Untuk itu, saran dan kritik yang membangun akan 
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Jakarta, Januari 2024 

Widi Astuti 



iii  

DAFTAR ISI 

 

Halaman 

HALAMAN SAMPUL ............................................................................................ i 

KATA PENGANTAR ........................................ ....................................................ii 

DAFTAR ISI .......................................................................................................... iii 

DAFTAR GAMBAR ........................................... ....................................................v 

DESAIN GRAFIS ................................................................................................... 1 

1. Desain grafis........................................................................................ 1 

2. Pengertian Grafis Berbasis Vektor dan Grafis Berbasis Bitmap ........ 1 

a. Grafis Bitmap ...................................................................................... 2 

b. Grafis Vektor ....................................................................................... 2 

INSTALASI DAN MEMAHAMI TOOLS ADOBE ILLUSTRATOR ................. 4 

1.1 Cara Menginstal Adobe Ilustrator 2021 .......................................... 4 

1.2 Interface Ilustrator ........................................................................... 6 

1.3. Tool Box ......................................................................................... 7 

1.4. Atribut Objek di Tool Box ............................................................ 17 

MENGGAMBAR DAN MELUKIS DENGAN TOOLS ..................................... 21 

A. Membuat File Baru ....................................................................... 21 

1. Menggambar dengan pen Tool...................................................... 22 

MEMBUAT BENTUK DARI SHAPING ............................................................ 26 

A. Membuat bentuk dari Shaping ...................................................... 26 

B. Membuat Logo dengan Adobe Ilmustrator. .................................. 28 

EFEK VISUAL VEKTOR .................................................................................... 33 

A. Transformasi Objek ....................................................................... 33 

KREASI MENGGUNAKAN FONT .................................................................... 36 

Kreasi Menggunakan Font ....................................................................... 36 

IMAGE BITMAB DENGAN SOFTWARE BERBASIS VECTOR ................... 41 

Image Bitmab Dengan Software Berbasis Vector .................................. 41 

PORTOFOLIO DARI SOFTWARE GRAFIS BERBASIS VECTOR ................ 58 

Portofolio dari Software grafis berbasis vektor ....................................... 58 

MENGENAL TOOLS PHOTOSHOP .................................................................. 64 



iv  

Pengenalan Adobe Photoshop.................................................................. 64 

Komponen dari Adobe Photoshop ........................................................... 74 

TOOLS-TOOLS SELECTION ............................................................................. 76 

Tools-Tools Selection .............................................................................. 76 

BERKERJA DENGAN EFFECT ......................................................................... 93 

Bekerja dengan Efek ................................................................................ 93 

OLAHAN FONT DAN EFEKNYA ................................................................... 101 

Olahan Font dan Efeknya ....................................................................... 101 

Tutorial membuat Vector Art .................................................................. 109 

MENGOLAH IMAGE VECTOR ....................................................................... 109 

Mengolah Image.......................................................................................124 

MENGOLAH IMAGE BITMAP ........................................................................ 109 

Presentasi Hasil Karya .............................................................................124 

DAFTAR PUSTAKA ......................................................................................... 109 

BIODATA ........................................................................................................... 109 

 

 



Modul Praktikum Desain Grafis 4 
 

DAFTAR GAMBAR 

 

Gambar 1. Perbedaan bitmap dan vektor 

Gambar 2. Extract File 

Gambar 3. Install Adobe Illustrator 

Gambar 4. Proses Install Adobe Illustrator 

Gambar 5. Tampilan Adobe Illustrator 

Gambar 6. Tampilan Adobe Illustrator 

Gambar 7. Tools Adobe Illustrator 

Gambar 8. Contoh Magic Wand Tool 

Gambar 9. Contoh Lasso Tool 

Gambar 10. Contoh Hasil Penggunaan Paintbrush Tool 

Gambar 11. Contoh Hasil Penggunaan Reflect Tool 

Gambar 12. Contoh Hasil Penggunaan Scale Tool 

Gambar 13. Contoh Hasil Penggunaan Shear Tool 

Gambar 14. Contoh Hasil Penggunaan Sprayer Tool 

Gambar 15. Contoh Hasil Penggunaan Mesh Tool 

Gambar 16. Contoh Hasil Penggunaan Gradient Tool 

Gambar 17. Contoh Hasil Penggunaan Live Paint Bucket 

Gambar 18. Contoh Hasil Penggunaan Scissors Tool 

Gambar 19. Contoh Hasil Penggunaan Knife Tool 

Gambar 20. Tab Pathfinder 

Gambar 21. Hasil Penggunaan Tab Pathfinder 

Gambar 22. Halaman membuat area kerja baru 

Gambar 23. Hasil dari pembuatan path 

Gambar 24. Path Terbuka dan Tertutup 

Gambar 25. Contoh hasil penggunaan path + 

Gambar 26. Contoh proses handle 

Gambar 27. Contoh Proses handle 

Gambar 28. Contoh Proses Path 

Gambar 29. Tampilan New Documen Adobe Ilustrator 

Gambar 30. Hasil Pengaturan Ukuran Corner Radius 



Modul Praktikum Desain Grafis 5 
 

Gambar 31. Hasil Pemberian Warna Gradient 

Gambar 32. Hasil Pemberian Warna Stroke 

Gambar 33. Hasil Pemberian Objek Lingkaran 

Gambar 34. Hasil Pemberian Warna Lingkaran Putih 

Gambar 35. Contoh Penggunaan Transform 

Gambar 36. Contoh Membuat dan Mengolah Font 

Gambar 37. Contoh Membuat dan Mengolah Font 

Gambar 38. Contoh Membuat dan Mengolah Font 

Gambar 39. Contoh Membuat dan Mengolah Font 

Gambar 40. Contoh Membuat dan Mengolah Font dengan menggunakan Path 

Gambar 41. Contoh Membuat dan Mengolah Font dengan teknik str 

Gambar 42. Contoh identitasi dan Tabulasi Font 

Gambar 43. Cara mematikan jenis Font 

Gambar 44. Contoh Gambar hasil edit Adobe Illustrator 

Gambar 45. Contoh cara edit dan embed Adobe Illustrator 

Gambar 46. Menggabungkan file raster 

Gambar 47. Mengatur file Adobe Illustrator baru 

Gambar 48. Memunculkan pengaturan guide 

Gambar 49. Memunculkan pengaturan guide 

Gambar 50. Cara menggunakan mode bitmap 

Gambar 51. Cara menggunakan mode bitmap 

Gambar 52. Mengatur output bitmap 

Gambar 53. Mengatur Halftone Screen option 

Gambar 54. Cara Mengembalikan Menjadi Grayscale 

Gambar 55. Cara membuat duplicate layer 

Gambar 56. Cara membuka kunci pada layar 

Gambar 57. Cara Menghapus background menggunalan Magic Wand Tool 



Modul Praktikum Desain Grafis 6 
 

Gambar 58. Cara memilih background 

Gambar 59. Cara menempatkan layer mask 

Gambar 60. Cara mengatur Halftone Screen option 

Gambar 61. Cara mengatur Halftone Screen option 

Gambar 62. Cara Merubah ukuran gambar 

Gambar 63. Cara menambahkan Layer Mask 

Gambar 64. Cara menambahkan Layer Mask 

Gambar 65. Hasil dari efek layar digital 

Gambar 66. Cara mengatur efek layar digital 

Gambar 67. cara membuat polar gaya cardioid 

Gambar 68. Hasil penambahan mask 

Gambar 69. Hasil mengubah warna screen layer dan adjustment layer 

Gambar 70. Hasil mengubah warna screen layer dan adjustment layer 

Gambar 71. Hasil penggunaan lighter weight 

Gambar 72. Cara save File 

Gambar 73. Tampilan tabel options 

Gambar 74. Cara mengubah paper size 

Gambar 75. Cara merubah layout 

Gambar 76. Cara menambah halaman 

Gambar 77. Hasil pengaturan layout 

Gambar 78. Cara membuat paragraph text 

Gambar 79. Cara membuat paragraph text 

Gambar 80. Cara memasukan gambar 

Gambar 81. Hasil memasukan gambar 

Gambar 82. Hasil Pengaplikasian Wrap paragraph Text 

Gambar 83. Hasil Pengaplikasian Wrap paragraph Text 



Modul Praktikum Desain Grafis 7 
 

Gambar 84. Tampilan simpan 

Gambar 85. Publish to PDF 

Gambar 86. Ekstrak file Adobe Photoshop 

Gambar 87. Install trial  

Gambar 88. Jendela Syarat dan Ketentuan 

Gambar 89. Sign In akun Adobe  

Gambar 90. Sign Up akun Adobe jika belum mempunyai akun 

Gambar 91. Pilih Versi Adobe Photoshop 

Gambar 92. Proses Instalasi  

Gambar 93. Instalasi Berhasil 

Gambar 94. Folder Aktivasi  

Gambar 95. Isi Folder program Files 

Gambar 96. folder Adobe Photoshop CS6 (64 Bit) 

Gambar 97. Replace file amtlib 

Gambar 98. Notifikasi untuk copy folder 

Gambar 99. Tampilan Adobe Photoshop CS6 

Gambar100 Cara menjalankan Photoshop 

Gambar 101. Tampilan Adobe Photoshop 

Gambar 102. Layers 

Gambar 103. Edit Channel 

Gambar 104. Pengenalan Tools 

Gambar 105. Marquee Tool 

Gambar 106. Lasso Tool 

Gambar 107. Polygonal Lasso Tool 

Gambar 108. Quic Selection & Magic Tool 

Gambar 109. Wand Tool 

Gambar 110. Crop & Slice Tool 

Gambar 111. Eyedropper, color,sample,Rulerand Note 

Gambar 112. Healing Brush & Patch Tool 

Gambar 113. Brush & Pencil Tool 

Gambar 114. Stamp Tool 

Gambar 115. Brush Tool 



Modul Praktikum Desain Grafis 8 
 

Gambar 116. Eraser Tool 

Gambar 117. Gradient & Paint Bucket Tool 

Gambar 118. Blur, Sharpen and Smudge Tool 

Gambar 119. Dodge, Burn and Spage Tool 

Gambar 120. Pen & Point Tool 

Gambar 121. Type/Text Tool 

Gambar 122. Path & Direct Selection Tool 

Gambar 123. Shapes Tool 

Gambar 124. Hand & Rotate Tool 

Gambar 125. Zoom 

Gambar 126. Set Foreground & Background 

Gambar 127. Contoh Lasso Tool 

Gambar 128. Contoh Poster  

Gambar 129. Contoh Media Promosi 

Gambar 130. Blur Effect 

Gambar 131. Contoh Dark Green 

Gambar 132. Contoh Gausian Blurr 

Gambar 133. Contoh Gausian Blurr 

Gambar 134. Contoh Filter Sketch 

Gambar 135. Contoh blend mode 

Gambar 136. Contoh Teks Bayangan 

Gambar 137. Contoh Green Front 

Gambar 138. Contoh character menu 

Gambar 139. Menu Layer Style 

Gambar 140. Contoh inner Glow 

Gambar 141. Contoh Embos 

Gambar 142. Contoh Gradient 

Gambar 143. Contoh Hasil 

Gambar 144. Efek Hulk 

Gambar 145. Stroke pada Styles 

Gambar 146. Contoh Fill Type 



Modul Praktikum Desain Grafis 9 
 

Gambar 147. Contoh Hulk 

Gambar 148. Contoh Elemen Pattern 

Gambar 149. Contoh Background 

Gambar 150. Import Foto ke Adobe Photoshop  

Gambar 151. Seleksi Objek Foto 

Gambar 152. Pemberian Filter ke Objek Foto 

Gambar 153. Berikan Efek ke Layer 

Gambar 154. Pemberian Filter 

Gambar 155. Unsharp mask 

Gambar 156. Efek Layer Detail Sedang 

Gambar 157. Efek Layer Detail Halus 

Gambar 158. Menambahkan adjusments levels 

Gambar 159. Hasil Simpan Vector Art 

Gambar 160. Tampilan Open Photoshop 

Gambar 161. Tampilan Photoshop Setelah Dibuka 

Gambar 162. Contoh Foto Pemandangan 

Gambar 163. Seleksi Saturation 

Gambar 164.Atur Kolom Saturation 

Gambar 165.    Select Inverse 

Gambar 166. Pengaturan Saturation 

Gambar 167. Deselect 

Gambar 168. Render Lense Flare 

Gambar 169. Pengaturan Brightness Lens Flare 

Gambar 170. Menyisipkan Gambar  

Gambar 171. Buat Work Path 

Gambar 172. Pengaturan Tolerance   

Gambar 173. Export Vector File 

  



Modul Praktikum Desain Grafis 10 
 

DESAIN GRAFIS 

 

 

1. Desain grafis 

Grafis adalah gambar yang tersusun dari koordinat-koordinat. Dengan demikian 

sumber gambar yang muncul pada layar monitor komputer terdiri atas titik-titik 

yang mempunyai nilai koordinat. 

Layar Monitor berfungsi sebgai sumbu koordinat x dan y. 

Desain grafis adalah suatu bentuk komunikasi visual yang menggunakan gambar 

untuk menyampaikan informasi atau pesan seefektif mungkin. Dalam disain grafis, 

teks juga dianggap gambar karena merupakan hasil abstraksi simbol-simbol yang 

bisa dibunyikan. disain grafis diterapkan dalam disain komunikasi dan fine art. 

Seperti jenis disain lainnya, disain grafis dapat merujuk kepada proses 

pembuatan, metoda merancang, produk yang dihasilkan (rancangan), atau pun 

disiplin ilmu yang digunakan (disain). 

Seni desain grafis mencakup kemampuan kognitif dan keterampilan visual, 

termasuk di dalamnya tipografi¹, ilustrasi, fotografi, pengolahan gambar, dan tata 

letak. 

Batasan Media Desain grafis pada awalnya diterapkan untuk media-media statis, 

seperti buku, majalah, dan brosur. Sebagai tambahan, sejalan dengan 

perkembangan zaman, desain grafis juga diterapkan dalam media elektronik, yang 

sering kali disebut sebagai desain interaktif atau desain multimedia. 

Batas dimensi pun telah berubah seiring perkembangan pemikiran tentang desain. 

Desain grafis bisa diterapkan menjadi sebuah desain lingkungan yang mencakup 

pengolahan ruang Prinsip dan unsur desain Unsur dalam desain grafis sama seperti 

unsur dasar dalam disiplin desain lainnya. Unsur-unsur tersebut (termasuk shape, 

bentuk (form), tekstur, garis, ruang,   dan   warna) membentuk prinsip-prinsip 

dasar desain visual. Prinsip-prinsip   tersebut, seperti keseimbangan (balance), 

ritme (rhythm), tekanan (emphasis), proporsi (proportion) dan kesatuan (unity), 

kemudian membentuk aspek struktural komposisi yang lebih luas. 
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2. Pengertian Grafis Berbasis Vektor dan Grafis Berbasis Bitmap Pada desain 

grafis, desain dibagi menjadi 2 kelompok yakni desain bitmap dan vector 

a. Grafis Bitmap 

Grafis desain bitmap dibentuk dengan raster/pixel/dot/titik/point koordinat. 

Semakin banyak jumlah titik yang membentuk suatu grafis bitmap berarti semakin 

tinggi tingkat kerapatannya. Hal ini menyebabkan semakin halus citra grafis, tetapi 

kapasitas filenya semakin besar. 

Ketajaman warna dan detail gambar pada tampilan bitmap bergantung pada 

banyaknya pixel warna atau resolusi yang membentuk gambar tersebut. Hal ini 

berkaitan erat dengan kemampuan monitor dan VGA( Video Graphic Adapter) yang 

digunakan. Jika gambar tampilan bitmap, resolusi yang ditampilkan pada monitor 

tinggi. Apabila resolusi rendah akan mengakibatkan gambar terlihat kasar, bahkan 

terlihat kabur berbentuk kotak-kotak (juggy) jika dilakukan pembesaran gambar. 

Satuan untuk ukuran grafis jenis bitmap ini adalah dpi( dot per inch) yang berarti 

banyaknya titik dalam satu inci. 

Beberapa grafis bitmap dapat temui di file komputer, yakni file komputer yang 

berekstensi : .bmp, .jpg, .tif, .gif, dan .pcx. Grafis ini biasa digunakan untuk 

kepentingan foto-foto digital. 

Program aplikasi grafis yang berbasis bitmap, antara lain : Adobe Photoshop, 

Corel Photopaint, Microsoft Photo Editor dan Macromedia Fireworks. Semua 

program tersebut menawarkan kemudahan dan kelengkapan fiturnya. 

 

b. Grafis vector 

Selain grafis jenis bitmap, ada grafis jenis vektor yang merupakan 

perkembangan dari sistem grafis bitmap (digital). Grafis ini tidak tergantung pada 

banyaknya pixel penyusunnya dan kondisi monitor karena tampilan vektor tersusun 

atas garis-garis. Tampilan akan terlihat jelas meskipun dilakukan pembesaran 

(zooming). 

Penggunaan titik-titik koordinat dan rumus-rumus tertentu dapat menciptakan 

bermacam-macam bentuk grafis, seperti lingkaran, segitiga, bujur sangkar dan 
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poligon. Dengan demikian, pemakaian grafis vektor akan lebih irit dari segi 

volume file, tetapi dari segi pemakaian prosessor akan memakan banyak memori. 

Program aplikasi grafis yang berbasis vektor antara lain: CorelDraw, Macromedia 

Free hand, Adobe Illustrator dan Micrografx Designer. 

Contoh gambar bitmap dan vector: 

Sumber gambar: (Kades, 2015) 

Gambar 1. Perbedaan bitmap dan vektor 

 

 

Bitmap Vektor 

1. Gambar kurang jelas ketika 

di perbesar 

1. Gambar tetap jelas ketika diperbesar 

2. Tersusun atas titik-titik/dot 2. Tersusun oleh garis kurva 

3. Ukuran file yang dihasilkan 

besar 

3. Ukuran file yang dihasilkan kecil 

4. Kualitas grafis bergantung 

dari banyaknya pixel 

4.   Kualitas grafis tidak bergantung 

banyaknya pixel 

5. Digunakan untuk gambar 

kompleks, berupa ragam warna 

dan bentuk beraneka ragam 

seperti foto dari dari hasil 

bidikan kamera. 

5. Digunakan untuk ilustrasi dengan 

bentuk geometris sederhana, warna 

solid atau gradasi tanpa terlalu 

banyak variasi warna. Cocok untuk 

logo dan jenis desain yang menglkan 

kesederhanaan bentuk 
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INSTALASI DAN MEMAHAMI TOOLS ADOBE ILLUSTRATOR 

 

1.1. Cara Menginstal Adobe Illustrator 2021 

Langkah-langkah menginstal adobe illustrator sebagai berikut: 

a. Download Software Adobe Illustrator 2021 

b. Kemudian ekstrak  file adobe illustrator dengan  cara klik kanan pada file 

winrar kemudian klik extract here 

 

Gambar 2. Extract File 

c. Kemudian klik kanan pada file yang telah di ekstrak, lalu klik kanan run as 

administrator 

 

Gambar 3. Install Adobe Illustrator 
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d. Kemudian pilih continue untuk melanjutkan 

Gambar 4. Proses Install Adobe Illustrator 

e. Tunggu proses loading berakhir. Dalam hal ini harus dipastikan bahwa proses 

loading berjalan dengan baik, tanpa ada masalah. 

f. Setelah itu Adobe Illustrator sudah siap untuk digunakan. 

 

Gambar 5. Tampilan Adobe Illustrator 
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1.2. Interface Ilustrator 

Setelah mengetahui perbedaan antara grafik vektor dan grafik bitmap serta 

telah menginstal adobe illustrator 2021, maka sudah saatnya kita mulai 

mengakrabkan diri dan sense kita ke dalam interface program Illustrator. Interface 

Illustrator mirip dengan interface pada produk-produk Adobe yang lainnya, seperti 

gambar di bawah ini: 

 

Gambar 6. Tampilan Adobe Illustrator 

Interface dari produk Adobe sebagian besar terdiri dari menu-menu yang 

berada dalam tab. Tab-tab tersebut masih bisa di-expand atau minimize dengan cara 

mengklik t panah yang tepat berada di samping nama tab atau dengan mengklik g 

nama masing-masing tab. Cara ini memudahkan kita untuk me- manage ruang kerja 

kita sesuai dengan tingkat kenyamanan 

 

Gambar 7. Tools Adobe Illustrator 
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1.3. Tool Box 

Gambar di samping adalah tool box dari Illustrator. Masing-masing 

tool mempunyai fungsi yang spesifik. Ada dua tool yang sangat vital, 

yaitu: 

    = Selection Tool (V) untuk memilih atau menyeleksi objek 

= Direct-Select Tool (A) untuk memilih atau menyeleksi objek 

yang lebih mendalam, misalnya memilih objek yang 

berada dalam suatu grup. Bisa juga untuk    memilih objek rumit yang 

sudah tergabung dalam  sebuah grup secara detail. 

Dua tool di atas selalu digunakan setiap akan mengedit atau 

memanipulasi suatu objek seperti menggeser, mewarnai, memotong 

dan lain sebagainya. 

 

TIPS : Untuk memilih lebih dari satu objek, pergunakan tombol 

Shift.Drag + Alt untuk membuat duplikat objek. Tekan icon agak lama bila ada 

segitiga kecil  di masing-masing icon ToolBox. 

Selain dua tool utama tersebut, masih ada deretan tool-tool di bawahnya yang 

mempunyai fungsi spesifik. 

= Magic Wand Tool (Y), untuk memilih objek lebih dari satu yang 

mempunyai atribut sama, seperti warna, ketebalan garis atau gradasi. 

Contoh: 

 

Gambar 8. Contoh Magic Wand Tool 
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ambar 10. Kurva Terbuka dan Tertutup 

= Lasso Tool (Q), untuk memilih objek dengan analogi tali laso, yaitu 

mengelilingi objek yang akan dipilih menggunakan tool ini. 

 

Gambar 9. Contoh Lasso Tool 

 

 

= Pen Tool (P), tool vital untuk membuat objek secara detail titik per 

titik atau anchor point sehingga membentuk sebuah kurva. Kurva dapat 

berbentuk kurva terbuka maupun kurva tertutup. Tiap titik atau anchor 

point mempunyai 2 handle yang menentukan bentuk kurva tersebut bila 

digeser dengan mouse. 

 

Kedua gambar di samping adalah kurva 

terbuka dan di bawahnya adalah kurva 

tertutup. Membuat objek dengan Pen Tool 

biasa disebut oleh para deigner grafis 

komputer dengan istilah ngepath. Karena 

titik-titik anchor point disebut juga titik-titik 

path. Syarat utama menggunakan program 

design grafis adalah kemampuan user untuk 

membuat path. Path digunakan untuk 

membuat objek yang sangat presisi. 

Bila icon Pen Tool ditekan agak lama maka akan ada beberapa icon tambahan  

yang pengoperasiannya berkaitan dengan pembuatan kurva atau path. 
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   =  Icon (+) berfungsi untuk menambah titik atau anchor point pada 

kurva/path. 

   =  Icon (-) berfungsi untuk menghapus titik atau anchor point pada 

kurva/path 

   =  (Shift+C) berfungsi untuk merubah sudutsudut tajam pada sebuah 

anchor point menjadi sudut lengkung. 

 

= Type Tool (T), tool untuk membuat dan mengedit text. Sama 

seperti Pen Tool, ada beberapa icon tambahan bila Type Tool ditekan agak 

lama. 

 

   = Icon Area Type Tool untuk mengetik text di dalam sebuah 

kurva atau path. 

=  Icon (Type on a path) untuk mengetik text mengikuti alur 

sebuah kurva atau path. 

= Icon ini berfungsi untuk mengetik text dengan orientasi vertikal 

= Icon ini sama fungsinya dengan Area Type Tool namun dengan 

orientasi pengetikan secara vertikal. 

= Icon ini sama fungsinya dengan Type on a path tool namun 

dengan orientasi pengetikan secara vertikal. 

= Line Tool (\), tool untuk membuat garis lurus. Sama seperti 

tool-tool sebelumnya, ada beberapa icon tambahan bila tool ini ditekan 

agak lama. Indikasinya adalah segitiga kecil di masing-masing icon 

Tool Box. 
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= Icon ini berguna untuk menggambar garis lengkung. Tekan 

Shift untuk membuat sudut presisi 450 

= Icon ini untuk membuat spiral. Tekan tombol panah atas/bawah 

untuk menambah dan mengurangi lengkung spiral. 

= Icon ini berfungsi untuk membuat Grid. Coba tekan tombol 

panah atas/bawah atau kanan/kiri untuk melihat perubahannya. 

= Icon berfungsi untuk membuat Polar Grid. Sama seperti tool 

diatas, Tekan tombol panah atas/bawah atau kanan/kiri untuk melihat 

perubahannya. 

= Rectangle Tool (M), tool untuk membuat gambar kotak. 

Sama seperti tool-tool sebelumnya, ada beberapa tool tambahan bila 

icon ini  ditekan agak lama. 

 

= Icon ini berguna untuk menggambar kotak bersudut lengkung 

(round corner). 

= Icon (L) untuk membuat lingkaran. Tekan Shift untuk 

membuat lingkaran sempurna. 

= Icon ini adalah Polygon tool. Tekan Shift untuk bentuk 

polygon yang sempurna atau tekan panah atas/bawah untuk menambah/ 

mengurangi jumlah  sisi  poligon. 

=  Icon berfungsi untuk menggambar bintang. Tekan Shift untuk 

bentuk bintang yang sempurna atau tekan panah atas/bawah untuk 

menambah/mengurangi jumlah sisi bintang. 

= Icon berfungsi untuk menggambar Flare. Saya jarang pakai, 

tapi coba saja untuk sekedar tahu 

= Icon Paintbrush Tool (B), tool untuk menggambar dengan efek kuas 
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Gambar 10. Contoh Hasil Penggunaan Paintbrush Tool 

 

= Pencil Tool (N), tool untuk menggambar bebas/freehand. 

Cocok digunakan dengan tablet. Tool ini kurang lebih mirip dengan Pen 

Tool. 

TIPS: Klik dua kali pada icon akan ada opsi-opsi untuk mengisi 

parameter tambahan. 

= Rotate Tool (R), tool untuk memutar objek. 

TIPS: Tekan Shift untuk memutar dengan sudut putaran 450. Jika objek 

ingin diputar sambil dibuatkan duplikatnya, tekan Alt. Klik dua kali 

pada icon akan ada opsi-opsi untuk mengisi nilai pemutaran objek. 

= Reflect Tool (O), tool untuk membuat refleksi atau kebalikan 

dari objek. 

TIPS: Jika objek sudah terefleksi, tekan Alt untuk membuat duplikat 

objek. Klik dua kali pada icon akan ada opsi untuk mengisi nilai 

refleksi objek 

 

Gambar 11. Contoh Hasil Penggunaan Reflect Tool 
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     = Scale Tool (S), tool untuk merubah ukuran objek. 

TIPS: Jika objek sudah terefleksi, tekan Alt untuk membuat duplikat 

objek. Klik dua kali pada icon akan ada opsi-opsi untuk mengisi nilai 

pembesaran objek. 

 

Gambar 12. Contoh Hasil Penggunaan Scale Tool 

= Shear Tool, tool untuk memiringkan objek. 

TIPS: Jika objek sudah terefleksi, tekan Alt untuk membuat duplikat 

objek. Klik dua kali pada icon akan ada opsi-opsi untuk mengisi nilai 

kemiringan objek. 

 

Gambar 13. Contoh Hasil Penggunaan Shear Tool 

 

=        Warp Tool (Shift+R), tool untuk mendistorsi objek. 

TIPS: Klik dua kali pada icon akan ada opsi-opsi untuk mengisi parameter 

perubahan objek. Saya persilahkan mencoba untuk bereksplorasi tool-

tool dari Warp Tool ini dengan objek yang ada 



Modul Praktikum Desain Grafis 22 
 

 

 

   = Free Transform Tool (E), tool untuk mentransformasi objek. Saya 

hampir tidak pernah menggunakan tool ini. 

= Simbol Sprayer Tool (Shift+S), tool untuk “menyemprotkan” objek 

yang  berada ditab Simbol  ke dalam  artwork. 

TIPS: Klik dua kali pada   icon   akan   ada opsi-opsi   untuk mengisi    

parameter “semprotan”. Klik terlebih dahulu gambar di tab Simbol 

lalu  tinggal semprotkan pada area kerja 

 

Gambar 14. Contoh Hasil Penggunaan Sprayer Tool 

 

 

= Untuk menggeser simbol yang sudah disemprotkan. 

 

 

     = Untuk merapatkan posisi antar simbol yang sudah disemprotkan 

= Untuk membesarkan ukuran simbol yang sudah disemprotkan. 

 

 

= Untuk memutar arah simbol yang sudah disemprotkan. 
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= Untuk mengisi warna simbol yang sudah disemprotkan. Pilih  dahulu 

warna solid foreground lalu klik pada simbol yang warnanya ingin 

dirubah. 

= Untuk merubah transparansi simbol yang sudah disemprotkan. 

Transparansi berubah menjadi modus Screen. 

= Untuk memberi efek dari tab Graphic Styles pada symbol yang sudah 

disemprotkan. Pilih dahulu simbol yang sudah disemprotkan lalu klik 

salah satu style dari tab Graphic Styles. Style akan diterapkan pada simbol 

yang dipilih. 

   = Column Graph Tool (J), tool untuk membuat grafik batang. 

= Mesh Tool (U), salah satu Power Tools-nya Illustrator. Berguna untuk 

mengedit gradient mesh, seperti mengurangi dan menambah kolom dan 

baris pada mesh. Tekan “U” lalu klik pada pada baris/kolom mesh yang 

akan ditambah. Untuk mengurangi baris/kolom, tekan “-“ sambil klik 

pada baris/kolom. 

 

Gambar 15. Contoh Hasil Penggunaan Mesh Tool 

 

TIPS: Klik warna foreground dari tab Swatches lalu pilih Eyedropper 
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Tool(I) kemudian klik+Alt pada anchor atau edge yang diinginkan. Pembahasan 

mendalam mengenai gradient mesh akan dibahas tersendiri. 

= Gradient Tool (G), tool untuk mengedit arah gradasi pada objek. Pilih 

objek yang sudah diaplikasikan gradasinya lalu drag kursor gradasi melintasi 

objek tersebut. Untuk membuat gradasi, pilih kurva/path tertutup lalu tekan 

“>” kemudian parameter gradasi dapat diakses pada tab Gradient. 

 

 

Gambar 16. Contoh Hasil Penggunaan Gradient Tool 

 

= Eyedropper Tool (I), tool untuk mengambil atribut pada suatu   objek. 

Dimana atribut itu nantinya akan diaplikasikan pada objek yang lain. 

TIPS:   Klik   warna   pada   suatu   objek,   lalu Alt+klik   pada objek 

yang lain. Cara ini berlaku juga untuk atribut lain seperti text, gradasi,  

stroke dan lain-lain. 

   = Blend Tool (W), tool untuk mengubah atribut blending objek. 

Klik g pada icon ini akan menampilkan menu Blend Options. Teknik 

blend objek 

 

   = Live Paint Bucket (K), tool express untuk mengisi warna pada sekumpulan 

path. Tool ini biasa dipakai untuk mewarnai objek yang 

sudah terusun lebih dari satu path tertutup, dengan cara “menuangkan” 

warna yang sudah dipilih. Cocok untuk mewarnai komik atau mewarnai 

(colouring) dengan teknik ngeblok. 

TIPS: Klik sekumpulan path, tekan K lalu arahkan sehingga path yang 

dimaksud akan tersorot (highlight outline merah) oleh kursor 
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bergambat ember cat. Lalu dengan sekali klik untuk mengisi 

warna/gradasi pada path  yang tersorot. 

 

 

 

Gambar 17. Contoh Hasil Penggunaan Live Paint Bucket 

 

= Live Paint Selection (Shift+L), dari namanya berarti tool ini untuk 

memilih path yang akan diwarnai dengan Live Paint Bucket 

= Slice Tool (Shift+K), tool untuk memotong gambar untuk keperluan 

pembuatan website. Saya tidak pernah menggunakan tool ini. Mungkin 

bila berkecimpung dalam web design akan memanfaatkan tool ini. 

 

= Scissors Tool (C), tool yang bermanfaat untuk “menggunting” atau 

membelah suatu kurva atau pathsite. Saya tidak pernah menggunakan tool 

ini. Mungkin bila berkecimpung dalam web design. 

akan memanfaatkan tool ini. 

 

Gambar 18. Contoh Hasil Penggunaan Scissors Tool 
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= Knife Tool, tool untuk memotong suatu objek.Prinsipnya sama dengan 

Scissors Tool, namun dengan pendekatan yang berbeda. 

TIPS: Pilih objek lalu klik+Alt bersamaan sambil drag mouse terhadap 

bagian objek yang akan dipotong. 

 

 

Gambar 19. Contoh Hasil Penggunaan Knife Tool 

= Hand Tool (H), berguna untuk menggeser bidang kerja sehingga lebih 

leluasa dalam menjelajah design yang kita buat. 

TIPS: Tekan spasi/space bar untuk menggeser bidang kerja. 

   = Zoom Tool (Z), tool untuk memperbesar atau memperkecil area   kerja. 

TIPS: Klik untuk zoom out dan Alt klik untuk zoom in 

 

 

 

1.4. Atribut Objek di Tool Box 

Berikut ini adalah icon di bagian bawah dari tool box yang menerangkan atribut 

pada sebuah objek, baik itu warna, gradasi bahkan tanpa warna ataupun gradasi: 

 

 

= Fill dan outline objek berisi warna, artinya objek tersebut 

mempunyai warna solid baik di dalam (fill) dan di sisi 

luar 

(outline). 

 

 

= Fill objek mengandung warna gradasi tanpa outline. 
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= Objek mempunyai warna outline tanpa fill. 

 

 

= Objek tanpa warna fill dan outline. 

 

 

   = Cara berpindah dari warna fill ke outline ataupun sebaliknya  cukup 

dengan klik pada salah satu icon (X) lalu klik warna yang diinginkan, baik 

dengan cara klik g pada icon atau memilih dari tab Swatches. Lalu untuk 

menukar warna fill ke outline atau sebaliknya cukup dengan cara manual 

seperti di atas atau dengan “shortcut ajaib”, Shift+X. 

 Setiap kali memberikan atribut suatu objek kita dapat menggunakan 

shortcut: 

 

< = Memberi warna pada objek. 

> = Memberi gradasi pada objek (gradasi default). 

? = Menghilangkan atribut warna ataupun gradasi pada objek. 

 

 

 

1. Tab Pathfinder 

 

Gambar 20. Tab Pathfinder 

Pembuatan objek tingkat lanjut dapat dilakukan dengan bantuan Tab 
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Pathfnder. Ada kalanya kita ingin membuat objek yang sesuai bentuknya dengan 

objek yang berdekatan. Prinsip kerja Tab Pathfinder mirip dengan cara kerja 

cetakan kue. Masukkan adonan kedalam wadah loyang berbentuk bintang misalnya, 

maka setelah kue itu matang akan terbentuk kue berbentuk bintang. Atau bila ada 

adonan tepung terigu yang dipotong dengan cetakan kue berbentuk bulan sabit, 

maka akan tercipta kue yang berbentuk bulan sabit juga. Objek ini nantinya akan 

disebut Compound Path. Banyak Compound Path yang bisa dibuat seperti contoh-

contoh ini: 

 

= Menggabungkan 2 buah objek menjadi 

bentuk baru. 
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= Memotong   objek dengan objek. Bentuk 

baru objek akan mengikuti objek 

pemotong. 

 

 

= Memotong objek dengan objek. Bentuk 

baru objek adalah   hasil   dari    

perpotongan kedua objek tersebut. 

 

 

= Sama seperti di atas, memotong objek 

dengan objek. Namun bentuk baru objek 

bukan hasil dari perpotongan kedua objek 

tersebut, melainkan gabungan kedua objek 

tapi tanpa 

bidang yang memotong. 

 

 

= Memotong objek menurut bentuk suatu 

objek. Hasil belahan akan membuat satu 

objek baru, yaitu perpotongan dari kedua 

objek tersebut. Ungroup objek untuk 

melihat 

hasilnya. 

 

 

= Memotong objek dengan objek. Objek 

yang dipotong akan mengikuti objek 

pemotong tetapi objek pemotong tidak 

hilang. 

 

 

= Mempunyai fungsi yang hampir sama 

dengan icon paling atas (Add to shape area). 

 

 

= Memotong objek, objek baru merupakan 

potongan dari objek yang dipotong. Objek 

hasil potongan akan mengikuti objek yang 

dipotong. 
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= Memotong objek namun akan 

m enghasilkan bentuk outline. 

 

= Bentuk objek yang dipotong akan 

mengikuti  atribut dari objek pemotong. 

 

 

Bila diinginkan, hasil bentuk objek Compound Path masih dapat diedit lagi 

menurut bentuk objek asalnya masing-masing. Cukup klik dua kali pada objek 

Compound Path yang baru dibentuk, maka akan ada kotak berwarna abu-abu 

(Isolated Group) yang membebaskan kita mengedit elemen pembentuk objek 

tersebut. Cara ini juga dapat dilakukan pada objek-objek yang sudah digrup, 

walaupun objek itu bukan merupakan Compound Path. 

Gambar 21. Hasil Penggunaan Tab Pathfinder 
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MENGGAMBAR DAN MELUKIS DENGAN TOOLS 

 

Setelah kita bekerja dengan interface dan menu-menu yang ada pada software 

Adobe Ilustrator, maka sudah saatnya kita mulai bekerja. 

A. Membuat File Baru 

Mempersiapkan area kerja (artboard) yang benar-benar baru dapat dibuat dengan 

mengklik menu File kemudian klik New (Ctrl+N). Gambar di bawah akan 

menerangkan beberapa hal yang perlu diketahui. 

 

Gambar 22. Halaman membuat area kerja baru 

• Name : Nama untuk artwork atau file baru 

• Size : Ukuran kertas, bila ukuran yang diinginkan tidak tersedia 

berarti kita harus memilih Custom dan masukkan ukuran 

tinggi dan lebar pada kolom Width dan Height. 

• Units : Satuan   ukuran   yang   akan   dipakai   pada   keseluruhan 

artwork/area kerja (cm, inch, dll). 
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• Width : Lebar bidang kerja. 

• Height : Tinggi bidang kerja. 

• Orientation : Orientasi bidang kerja atau kertas, horizontal atau vertikal. 

• Color Mode :   Modus warna yang akan digunakan. Apabila arwork yang akan 

ditujukan ke percetakan, maka gunakan CMYK. Sedangkan 

apabila untuk tampilan di monitor saja gunakan RGB. 

 

1. Menggambar dengan Pen Tool 

Pen tool   adalah tool menggambar vital 

yang wajib dimiliki oleh program grafis manapun. Tool ini memungkinkan kita 

menggambar secara presisi terhadap bentuk-bentuk yang kita inginkan. Path 

merupakan dasar dari bentuk yang akan kita buat nantinya. 

Untuk membuat path sederhana seperti diatas, langkah-langkahnya adalah: 

a. Klik icon (P)  

b. Drag mouse dari titik (anchor  point) A. 

c. Klik sambil drag di titik B (+ Alt), C, D dan kembali lagi ke titik A 

Gambar 23. Hasil dari pembuatan path 

 

d. Buatlah bentuk dengan bantuan titik di atas menurut bentuk objek yang 

inginkan. 

e. Apabila membuat path tertutup maka akan ada kursor berlambang bila kembali 

ke titik awal (disebut juga titik penutup, bila memang menginginkan path 

tertutup). 

f. Masing-masing titik masih dapat digeser sesuka termasuk juga handle- handle-

nya sehingga bentuk yang diinginkan tercapai. 
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g. Menggeser handle harus pada ujungnya. 

Gambar 24. Path Terbuka dan Tertutup 

Sekedar kilas balik ke Pertemuan I, icon-icon dan shortcut di bawah ini akan selalu 

sering dipakai: 

Apabila ingin menambah titik pada path, tekan + pada keyboard dan lakukan pada 

path yang diinginkan dan di lokasi yang tentukan sendiri. Akan terlihat kursor Pen 

dan lambang +. Contoh: 

 

Gambar 25. Contoh hasil penggunaan path + 

Sedangkan jika ingin menghapus salah satu titik cukup tekan – pada keyboard lalu 

klik pada titik atau anchor point yang ingin dihapus. Kursor akan berubah menjadi 

kursor pen dan lambang –. 

Bila bentuk yang diinginkan masih belum didapat, teknik selanjutnya adalah 

“bermain” dengan handle pada masing-masing titik. Handle inilah yang akan 

menentukan bentuk akhir dari hubungan antar titik-titik yang kita buat. Berikut 

contoh-contoh menggerakan handle: 
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Gambar 26. Contoh proses handle 

 

Gambar 27. Contoh Proses handle 

Dari contoh di atas dapat disimpulkan bahwa pembuatan objek dengan Pen tool 

atau istilahnya nge-path hanya berkisar pada klik, drag titik dan handle. Sisanya 

adalah sense kita yang mengatakan objek itu sudah proporsional atau belum. Nge- 

path adalah bagian yang paling saya sukai di Illustrator . 
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Gambar 28. Contoh Proses Path 
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MEMBUAT BENTUK DARI SHAPING 

 

Menggambar dengan Shape Tools 

Mungkin istilah Shape tool tidak ada di dalam Illustrator, saya menulis hal itu 

untuk memberi gambaran bahwa untuk membuat bentuk atau shape secara instan 

di Illustrator cukup mudah. Misalnya bila ingin membuat sebuah kotak persegi atau 

lingkaran maka cukup mengakses icon-icon 

 

ini maka objek yang diinginkan pun akan terbentuk. Jika menginginkan bentuk dari 

salah satu icon tersebut cukup tahan agak lama sehingga icon yang mewakili bentuk 

objek yang akan dibuat menjadi terpilih/aktif. Setelah icon aktif maka tinggal 

membuat objeknya di bidang kerja/artboard. 

TIPS: Klik pada area kerja untuk menampilkan parameter tambahan (Options) 

terhadap objek yang akan kita buat (jadi objek tersebut memang belum dibuat 

sebelumnya). Parameter tambahan dapat dilihat pada tabel di bawah ini. 

 

 

Klik   icon atau tekan M untuk 

membuat kotak. Klik pada area kerja 

untuk memunculkan kotak dialog 

Rectangle. Nilai Width dan Height 

adalah luas kotak yang akan dibuat. 

 

 

 

Klik   icon atau tekan L untuk 

membuat lingkaran. Klik pada area 

kerja untuk memunculkan kotak 

dialog Ellipse. Nilai Width dan Height 

adalah 

luas lingkaran yang akan dibuat. 
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Klik icon lalu klik area kerja untuk 

memunculkan kotak dialog Rounded 

Rectangle. Selain nilai Width dan 

Height, nilai Radius sudut lengkung 

dapat dimasukkan di sini. 

 

 

 

Klik icon    lalu klik area kerja 

untuk memunculkan kotak dialog 

Polygon. Masukkan nilai radius dan 

jumlah sisi poligon yang diinginkan. 

Untuk membuat segitiga masukkan 

angka 3 pada kolom Sides. 

 

 

Klik icon lalu klik area kerja untuk 

memunculkan kotak dialog Star. 

Masukkan nilai radius 1 dan 2 dan 

jumlah titik yang diinginkan. 

 

Klik icon   untuk membuat Lens 

Flare secara vektor. Beberapa 

parameter menentukan daya pancar 

sinar. 

Dari keterangan-keterangan di atas dapat disimpulkan bila kita menghendaki 

ukuran objek yang akan kita buat maka angka-angkanya masih dapat dimasukkan 

ke dalam parameter Width dan Height. Namun, setiap penekanan tombol Shift 

ketika sedang drag mouse untuk membuat objek akan menghasilkan objek yang 

sama sisi. 

2. Menggambar dengan Line Tool 

Menggambar yang paling gampang 

ternyata bukan menggambar benang kusut, 

tetapi menggambar garis. Apabila benang 

kusut masih harus mencorat coret kertas, 

sedangkan menggambar garis cukup 
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sretttt… jadilah garis. Pada Illustrator menggambar Line (\) atau garis lurus cukup 

klik icon   . Setelah itu cukup drag di atas artboard/area kerja. Tekan Shift untuk 

membuat garis dengan sudut kemiringan 450. Seperti biasa, masih ada parameter 

tambahan untuk yang menginginkan lebih dan juga masih dengan cara- cara di atas, 

yaitu klik artboard untuk memunculkan kotak dialog Line Segment Tool Options. 

Sedangkan bila ingin membuat mata panah pada 

garis cukup klik menu Effect  Stylize  Add 

Arrowheads (Alt+Ctrl+Shift+E), maka akan 

muncul kotak dialog Add Arrowheads. Masukkan 

nilai pembesaran mata panah. Kolom Start dan 

End menentukan di ujung mana akan 

memunculkan mata panah, sedangkan icon 

dan untuk memilih model mata anak 

panah. Untuk membuat anak panah ternyata tidak hanya berlaku untuk Line/garis 

saja tetapi juga berlaku untuk semua objek, termasuk path. Untuk menghilangkan 

anak panah, drag icon ke Trash. 

Selain membuat garis lurus biasa, membuat garis melengkung dapat dilakukan 

dengan klik icon . 

 

Membuat Logo dengan Adobe Illustrator 

Adobe Illustrator adalah software editor desain grafis berbasis vektor yang banyak 

digunakan oleh para desainer terkenal. Logo merupakan lambang penting yang 

digunakan untuk sebagai ikon lebel profil. 

1. Buat file baru, pilih menu File, New, atau bisa juga dengan menekan      shortcut 

Ctrl + N. setelah itu akan keluar jendela seperti di bawah ini 
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Gambar 29. Tampilan New Documen Adobe Ilustrator 

 

2. Isi data sesuai dengan keinginan kamu. Pada tutorial ini menggunakan ukuran 500 x 

500 px. Tentu saja tidak harus sama dengan gambar di atas. Jika sudah, langsung 

tekan tombol “Ok”. pilih Rectangle Tool  

atau   bisa   juga   dengan   menekan   tombol M. Lalu    tentukan    ukuran Corner 

Radius menjadi 0.58 cm. mengatur corner radius sangat mudah, cukup klik salah 

satu dari 4 lingkaran yang ada dalam kotak, lalu geser. Jika sudah maka hasilnya 

seperti gambar di bawah 
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Gambar 30. Hasil Pengaturan Ukuran Corner Radius 

3. Berikan warna gradient pada kotak dengan menekan icon Gradient Tool 

atau menekan tombol G. Tentukan warna gradient semirip mungkin dengan warna icon 

Instagram, lalu geser garis gradient dari pojok atas kanan kotak hingga pojok bawah kiri 

kotak seperti gambar di bawah 

 

Gambar 31. Hasil Pemberian Warna Gradient 

4. Buat objek kotak lagi, biar mudah duplikat saja kotak tadi yang sudah kita buat. 

Caranya klik objek, lalu tekan alt + geser kursor, atau bisa juga copy paste seperti 

biasa dengan menekan ctrl + C lalu ctrl + V. Swap warna “fill” objek kedua 

menjadi warna “stroke” dengan tekan shift + X, lalu ganti warna dengan warna 

putih dan atur “stroke” menjadi “3pt”. jika sudah maka hasilnya seperti gambar di 
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bawah 

 

 

Gambar 32. Hasil Pemberian Warna Stroke 

 

5. Lalu buat objek lingkaran, tekan tombol L. buatlah lingkaran dengan menahan 

tombol shift sehingga ukuran lingkaran bisa presisi. Tempatkan lingkaran ditengah 

logo, dengan cara blok semua objek, setelah itu tekan horizontal dan vertical   

align center di property bar. 

Jika sudah maka hasilnya seperti ini: 

 

Gambar 33. Hasil Pemberian Objek Lingkaran 

 

6. Buat objek lingkaran lagi berwarna putih, kali ini warna “stroke” dihilangkan, 
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letakkan objek persis di pojok atas kanan lingkaran pertama. Jika sudah maka 

hasilnya seperti ini 

 

 

Gambar 34. Hasil Pemberian Warna Lingkaran Putih 

7. Sekarang membuat warna kuning pada bagian bawah logo. Tekan L untuk 

membuat lingkaran. Buat 2 lingkaran dengan ukuran yang berbeda, beri warna 

kuning cerah untuk lingkaran kecil dan beri warna orange untuk lingkaran yang 

lebih besar. Lalu blok kedua objek dan tekan horizontal dan vertical align center 

(Caranya sudah disebutkan di atas), lalu tekan ctrl + G untuk membuat kedua objek 

menjadi satu grub. Lalu buat objek menjadi blur, tekan Effect > Blur > Gaussian 

Blur di menubar, atur angka menjadi “20”. Jika sudah, maka tampilan akan seperti 

gambar di bawah 
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EFEK VISUAL VEKTOR 

 

A. Transformasi Objek 

Setelah mempelajari bagaimana membuat objek dan sudah sedikit demi 

sedikit hapal dengan icon-icon di Illustrator beserta fungsinya, maka tiba saatnya 

untuk (membiasakan) mengolah objek yang sudah buat. Transformasi objek yang 

saya maksudkan di sini adalah bagaimana cara mengolah objek mulai dari 

menduplikasi, menggeser memutar, merefleksikan, rescale dan memiringkan. Cara 

transformasi objek. 

Dari icon-icon yang ada di tool box 

dan tab Transform. Pada bab ini 

akan bahas sedikit berbeda namun 

dengan hasil yang sama, yaitu 

dengan cara klik kanan pada objek 

yang akan kita edit. Satu 

hal yang mendasar adalah cara menduplikasikan objek, yaitu dengan klik pada suatu 

objek, baik objek tunggal ataupun grup – dan tekan Alt sambil drag objek tersebut 

ke tempat lain. Maka kita sudah menggkan atau menduplikasi objek tersebut, tanpa 

susah-susah membuatnya kembali, bukan? Duplikasi objek pun masih dapat 

digabungkan dengan operasi objek yang lain, seperti memutar objek sambil 

menduplikasi. Membuat objek jari-jari roda dapat menggunakan teknik ini. 

 

Gambar 35. Contoh Penggunaan Transform 
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= Memindahkan objek 

Masukkan angka untuk menentukkan 

seberapa jauh objek akan digeser. Tekan 

Copy akan menduplikasi objek sambil 

bergeser. 

 

 

= Memutar objek 

Masukkan angka untuk menentukkan 

seberapa besar derajat perputaran objek. 

Tekan Copy akan menduplikasi objek sambil 

diputar. 

 

 

= Merefleksikan objek 

Pilih tipe refleksi dan sudut perputaran objek 

bila diperlukan. 

 

= Merubah ukuran objek 

Scale Uniform berarti objek dirubah 

ukurannnya dalam bentuk yang proporsional. 

Sedangkan Non-Uniform akan menghasilkan 

bentuk yang tidak proporsional. 

 

= Memiringkan objek 

Objek dimiringkan dengan orientasi 

Horizontal atau Vertical, sudut kemiringan 

dapat diatur derajatnya. 

  = Masih ada lagi cara mentransformasi objek, 

yaitu melalui kotak dialog Transform Each 

(Alt+Shift+Ctrl+D). Di sini dapat memegang 

kendali secara penuh atas segala Perubahan/ 

transformasi seperti yang diterangkan di atas 
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hanya dengan satu kotak dialog. tinggal menggeser slider atau langsung 

memasukkan nilai transformasi yang dikehendaki. 

TIPS: masih dapat mengulangi efek transformasi yang terakhir diterapkan dengan 

menekan Ctrl+D. Lakukan berulang-ulang bila diperlukan. 
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KREASI MENGGUNAKAN FONT 

 

Fasilitas pengolahan teks di Illustrator. Illustrator mempunyai kemampuan untuk 

menggabungkan teks dengan ilustrasi yang kita buat. Misalnya dalam pembuatan materi 

publikasi seperti poster, booklet, brosur dan lain sebagainya. Unsur teks akan menuntun cara 

berkomunikasi kita dalam menyampaikan sesuatu dalam media gambar atau ilustrasi. Karena 

prinsip dasar design grafis adalah menyampaikan pesan kepada audiens baik lewat media 

gambar dan teks. 

Berikut ini cara membuat teks dan mengolahnya di Illustrator: 

 

Gambar 36. Contoh Membuat dan Mengolah Font 

1. Tekan atau klik icon    sehingga akan muncul kursor teks dan klik pada 

bidang kerja. 

2. Apabila teks yang diinginkan terdiri dari satu paragraf atau lebih, drag pada 

bidang kerja sehingga membentuk sebuah area/bidang kotak. 

3. Pada bidang inilah tempat teks itu diketik. Besar kecilnya bidang nanti dapat 

diatur seperti rescale sebuah objek. Bahkan mengaplikasikan bentuk path pun 

dapat dilakukan di sini. 

4. Ketik teks yang inginkan. 

5. Setelah selesai tekan Esc. 

6. Atur semua properti atau atribut teks pada tab Character (Ctrl+T) seperti gambar 

di atas. Jika diperlukan, atur pula penyusunan paragrafnya. Tab Paragraph 

berada di samping tab Character. Lihat gambar di bawah ini. 
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Gambar 37. Contoh Membuat dan Mengolah Font 

 

Text box area seperti gambar 

disamping ini sebenarnya berupa 

sebuah objek kotak yang dapat dirubah 

bentuknya dengan mudah seperti kita 

membuat atau mengedit path biasa. 

Sangat bermanfaat bila ingin membuat 

teks yang berupa paragraph. 

Gambar 38. Contoh Membuat dan Mengolah Font 

Untuk membuat teks seperti disamping: 

1. Buat gambar berbentuk apa saja. 

2. Klik icon  pada tool box. 

3. Ketik teks yang diinginkan di dalam gambar tersebut. 
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4. Teks   akan   mengikuti bentuk objek tersebut dan otomatis mengatur 

perataannya (alignment). 

5. Objek masih dapat diedit seperti contoh-contoh transform di atas. 

 

Adakalanya kita ingin membuat text yang mengikuti alur dari sebuah path 

seperti contoh berikut: 

1. Buat path dengan pen tool. 

2. Klik icon  pada tool box. 

3. Ketik teks yang diinginkan pada path tersebut. 

4. Klik menu Type Type on pat Type on path options untuk mengatur 

beberapa paramater text. 

Gambar 39. Contoh Membuat dan Mengolah Font 

Tidak sulit mengatur aliran teks sesuai bentuk path, cukup dekatkan kursor mouse 

ke pangkal teks lalu geser maka teks akan bergeser. Bentuk kursor akan berubah 

seperti ini . 

Lihat gambar di bawah ini. 
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Gambar 40. Contoh Membuat dan Mengolah Font dengan menggunakan Path 

Atau dapat juga membuat yang seperti ini, yaitu teknik str untuk membuat logo 

sederhana. 

Gambar 41. Contoh Membuat dan Mengolah Font dengan teknik str 

 

Sedangkan orientasi arah teks yang lain dapat diakses melalui menu Type on path 

options. Last but not least adalah pengaturan tabulasi dan identasi paragraf, cukup 

sorot suatu paragraf dan tekan Ctrl+Shift+Alt untuk mengakses penggaris teks 

untuk tabulasi. 

 

 

Gambar 42. Contoh identitasi dan Tabulasi Font 
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Hal-hal yang perlu diperhatikan! 

“Matikan” semua jenis teks ketika mengirimkan gambar kepada orang lain. Karena 

teks yang masih bisa diedit (editable text) dikhawatirkan akan berubah formatnya 

jika dibuka di komputer orang lain yang tidak menggunakan jenis font yang sama. 

Hal ini dapat terjadi apabila kita menggunakan font-font untuk teks dan (file) yang 

dibuka di komputer lain yang tidak menggunakan jenis font yang sama. 

Cara mematikan font/teks adalah cukup dengan menyorot teks yang akan kita 

konversi ke dalam bentuk path dan masuk ke menu Type Create Outlines 

(Shift+Ctrl+O). Maka teks yang dimatikan jenis font-nya akan tampil dengan 

format atau bentuk aslinya dan tidak akan berubah walaupun dibuka di komputer 

lain yang tidak menggunakan font yang sama dengan kita. Karena teks sudah 

berubah menjadi path dan tidak dapat diedit isi teksnya. Kecuali diedit seperti 

mengedit path biasa. 

Gambar 43. Cara mematikan jenis Font 
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IMAGE BITMAB DENGAN SOFTWARE BERBASIS VECTOR 

 

Sudah merupakan hal biasa jika kita bekerja dengan objek vektor dan raster 

sekaligus, Adobe Illustrator memungkinkan hal tersebut. Malah ini menjadi salah 

satu kelebihannya. Objek raster/bitmap dapat dipanggil dengan menu File  Place, 

lalu kita tinggal meletakkan file gambar raster/bitmap ke artwork kita di Adobe 

Illustrator. 

Apabila membuat kemasan baiknya dengan membuatnya di Adobe Photoshop lalu 

jika dibutuhkan teks untuk body teks atau teks spesifikasi produk maka saya akan 

membuatnya di Adobe Illustrator. Hal ini dikarenakan teks pada Adobe Illustrator 

lebih tajam, tidak bergerigi dan warna hitamnya murni 100% Black. Sehingga jika 

film pada percetakan tergeser maka tidak akan mengganggu teks. 

Lihat Contoh: 

Gambar 44. Contoh Gambar hasil edit Adobe Illustrator 

File-file yang didukung oleh Adobe illustrator adalah: 

File Adobe Photoshop PSD 

File bitmap/raster BMP, JPEG, TIFF, GIF, PNG 

File vektor standard EPS 

File AutoCAD DWG, DXF 
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Gambar 45. Contoh cara edit dan embed Adobe Illustrator 

Keterangan: 

A = Transparency Interaction 

B = File link hilang 

C = Link di-embed (digabung dengan artwork). 

D = Ada link yang dimodifikasi di tempat asalnya. 

E = File yang di-link. 

Klik Embed untuk menggabungkan objek/file raster ke dalam artwork Illustrator. 

Ukuran file akan membengkak namun akan memudahkan kita jika file tesebut 

mengalami perubahan di harddisk. Jika belum di-embed, file raster masih dapat 

diedit oleh program dimana file tersebut berasal. 

 

 

A. Hal Mendasar: Perbedaan antara bitmap dan vektor 

Hal mendasar sebelum mempelajari Illustrator adalah kita harus tahu 

perbedaan antara grafik vektor dan grafik bitmap. Grafik vektor tidak akan 

mengalami penurunan kualitas bila dimensi gambarnya diperbesar karena tidak 

bergantung dengan resolusi. Sedangkan grafik bitmap atau raster akan mengalami 

penurunan kualitas bila ukurannya dibesarkan. 
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Gambar 46. Menggabungkan file raster 

Desain grafis berbasis bitmap adalah sebuah desain yang dimana objek grafis atau 

gambarnya tersusun dari raster/pixel/dot sehingga jika gambar diperbesar maka 

akan tampak blur. 

Adapun langkah-langkah mengedit gambar bitmab : 

1. Mengatur File Adobe Illustrator Baru 

File New kemudian beri nama document Music Poster. Setel width menjadi 

1270px dan height hingga 1600px. Lalu atur Resulution menjadi 72px, 

kemudian Klik OK. 
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Gambar 47. Mengatur file Adobe Illustrator baru 

2. Tekan Command-R untuk memunculkan aturan di sekitar dokumen. Arahkan 

ke view New Guide. Pada opsi New Guide window, pilih Horizontal dan atur 

guide menjadi 50p, kemudian Klik OK. 

Lakukan hal yang sama untuk sisi lain dokumen dengan mengurai 50px dari 

ukuran akhir 

 

Gambar 48. Memunculkan pengaturan guide 

3. Untuk membuat layout yang menarik, kita akan membuat layout yang sedikit di 

luar pusat. Tujuannya adalah untuk menciptakan sesuatu yang tidak terduga, 

alih-alih tata letak terpusat yang teratur. Menuju ke View  New Guide. Pada 

opsi New Guide window, pilih Vertical dan atur panduan ke 800px, kemudian 

Klik OK. Mari lakukan hal yang sama untuk panduan horizontal, atur ke 980px, 

kemudian Klik OK. 
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Gambar 49. Memunculkan pengaturan guide 

4. Cara menggunakan mode bitmap 

Bitmap adalah alternatif untuk vektor di mana gambar diubah menjadi piksel 

hitam dan putih. Teknik ini biasanya digunakan untuk sablon atau koran. Dapat 

dipilih antara beberapa pola yang berbeda dan mengatur jumlah detail yang 

ingin kita pertahankan. Untuk membuat gambar yang disaring, kita perlu 

membukanya secara terpisah. 

Pada Layers panel, kemudian buka kunci layer utama dengan mengklik dua 

kali pada kunci. Lalu klik OK pada New Layer option window. 

 

Gambar 50. Cara menggunakan mode bitmap 

5. Arahkan ke Image Mode Grayscale, diikuti oleh Image Mode  Bitmap. 

Kemudian Klik OK pada Flatten Layers option window. 

 

Gambar 51. Cara menggunakan mode bitmap 
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6. Pada Bitmap option window, atur Output menjadi 72 Pixels/Inch. Kemudian 

pada bagiah Method, pilih Use: Halftone Screen. Lalu Klik OK. 

 

Gambar 52. Mengatur output bitmap 

7. Pada tampilan Halftone Screen option, kemudian atur Frequency menjadi 2 

Lines/Inch, setelah itu Angle ke 45 degrees dan Shape ke Line. Lalu Klik OK. 

 

Gambar 53. Mengatur Halftone Screen option 

8. Untuk menggunakan gambar, kita perlu mengembalikannya ke Grayscale. 

Arahkan ke Image Mode Grayscale. Kemudian pada Grayscale option 

window, kemudia atur Size Ratio menjadi 1. Lalu Klik OK. 
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Gambar 54. Cara Mengembalikan Menjadi Grayscale 

9. Pada Layers panel, Right click Duplicate Layer. Kemudian pada Duplicate 

Layer option window, beri nama layer menjadi headphone. Pada bagian 

Destination, pilih file Music Poster. Lalu Klik OK. 

Tutup isolated headphones image. Kemudian tidak perlu disimpan karena sudah 

menggukannya ke dalam main file. 

 

Gambar 55. Cara membuat duplicate layer 

10. Buka gambar ke 2. Pada Layers panel, kemudian double click pada layer untuk 

membuka kuncinya. Pada New Layer option window, kemudian klik OK. 
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Gambar 56. Cara membuka kunci pada layar 

11. Untuk gambar khusus ini, kita perlu menghapus background untuk memiliki 

isolated DJ. Pada Layers panel klik Add a layer mask button. Kemudian pada 

Tools panel, pilih Magic Wand Tool (W). Setelah itu Klik untuk memilih 

background, dan tahan tombol Shift pada keyboard untuk menambah pilihan. 

Tidak perlu menjadi sempurna, tetapi kita perlu menghapus sebanyak mungkin 

background . 

 

Gambar 57. Cara Menghapus background menggunalan Magic Wand Tool 

12. Setelah memilih background, tekan Command-I pada keyboard untuk 

membalikkan mask. Pastikan melakukan hal ini pada Layer Mask yang kita 

tambahkan ke main layer. Untuk membatalkan pilihan, tekan Command-D. 
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Gambar 58. Cara memilih background 

13. Untuk melanjutkan, kita perlu menerapkan Layer Mask ke main layer. Pilih 

Layer Mask (Right Click Apply Layer Mask). 

Gambar 59. Cara menempatkan layer mask 

14. kemudian klik menu Image Mode Grayscale, diikuti oleh 

Image Mode  Bitmap. Kemudian Klik OK pada Flatten Layers option. pada 

Bitmap option window, atur Output menjadi 240 Pixels/Inch. Kemudian pada 

bagian Method, pilih Use: Halftone Screen, lalu Klik OK. 
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Pada Halftone Screen option window, atur Frequency menjadi 25 Lines/ Inci, 

Angle ke 45 degrees, dan Shape menjadi Round. Kemudian Klik OK. Lalu 

kembalikan file menjadi ke Grayscale. Dengan cara klik Image Mode  

Grayscale. Pada Grayscale option window, atur Size Ratio menjadi 1. 

Kemudian Klik OK. 

 

Gambar 60. Cara mengatur Halftone Screen option 

15. kemudian pada layer, klik kanan Duplicate Layer. Pada Duplicate Layer 

option window, beri nama menjadi layer DJ. Pada bagian Destination, pilih 

file Music Poster. Kemudian klik OK. Setelah itu Tutup gambar. 

 

Gambar 61. Cara mengatur Halftone Screen option 

16. Kemudian rubah ukuran gambar agar sesuai dengan ruang. Dimulai dengan 

DJ   layer.   Tekan   Command-T    untuk    mengubah.    Arahkan ke Options 

bar,    dan    aktifkan Maintain    Aspect     Ratio button.     Lalu atur Width atau 

Height menjadi 85%, kemudian tekan Enter. Tempatkan gambar di sisi kanan 
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poster. 

 

Gambar 62. Cara Merubah ukuran gambar 

17. Kemudian tambahkan Layer Mask untuk menghapus bagian dari layer yang 

tidak kita gunakan. Klik pada tombol Add Layer Mask. Dengan menggunakan 

Rectangular Marquee Tool (M), pilih sisi kiri poster. Tekan Command-I untuk 

mengambalikan mask. Tekan Command-D untuk membatalkan pilihan. 

 

Gambar 63. Cara menambahkan Layer Mask 

18. Kemudian beralih kepada headphones layer. Tekan Command-T untuk 

mengubah. Kemudian arahkan ke bilah Options, dan aktifkan tombol Maintain 

Aspect Ratio. Setel Width atau Height menjadi 22%, lalu tekan Enter. Kemudian 

tempatkan gambar di quadrant kiri bawah poster. 

Seperti pada langkah di atas, tambahkan Layer Mask dan menghapus bagian 



Modul Praktikum Desain Grafis 62 
 

yang tidak akan kita gunakan. Klik pada tombol Add Layer Mask. 

Menggunakan Rectangular Marquee Tool (M), pilih sisi atas gambar. Lalu 

tekan Command-I untuk membalikkan mask. Tekan Command-D untuk 

membatalkan pilihan. 

 

Gambar 64. Cara menambahkan Layer Mask 

19. Membuat Efek Layar Digital 

Pada Layers panel, buat layer baru dengan menekan Shift-Command-N. 

Kemudian beri Nama layer Screen. Kemudian klik OK. Lalu Pilih Brush Tool 

(B) dari panel Tools. Kemudian klik untuk mengubah pengaturan. Atur Size 

menjadi 400px dan Hardness menjadi 0%. Dengan menggunakan kode warna 

di bawah, lalu brush halaman untuk menutupinya. 

• Yellow: #ffb20e 

• Pink: #ff12de 

• Blue: #0078ff 
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Gambar 65. Hasil dari efek layar digital 

20. Arahkan ke Filter Distort Wave. Pada Wave option window, gunakan 

pengaturan berikut: 

• Number of Generators: 1 

• Type: Sine 

• Wavelength: Min. 1 and Max. 2 

• Amplitude: Min. 295 and Max. 375 

• Scale: Horiz. 100% and Vert. 100%. 

• Undefined Areas: Repeat Edge Pixels 
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• Kemudian Klick OK. 

Gambar 66. Cara mengatur efek layar digital 

21.  Untuk membuat pola gaya cardioid, kita perlu menjalankan gambar ini melalui 

proses kedua. Sementara pada layer yang sama, arahkan ke Filter  Distort  

Polar Coordinates. Pada Polar Coordinates option window, pilih opsi Polar 

Rectangular. kemudian klik OK. 

 

Gambar 67. cara membuat polar gaya cardioid 

22. Dengan menggunakan Rectangular Marquee Tool (M), pilih quadrant kiri atas 

poster. Tekan Shift untuk menambah pilihan dan pilih bagian kecil di sisi kanan 

bawah. Setelah memiliki dua pilihan, klik pada tombol Layer Mask. Ini akan 
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membuat mask di sekitar seleksi. 

 

Gambar 68. Hasil penambahan mask 

23. Untuk mengubah warna Screen layer, klik pada Create a new fill or adjustment 

layer  Hue/Saturation. Panel Properties akan terbuka secara otomatis. Jika 

ingin melakukan hal sebaliknya, maka double-click pada thumbnail layer 

Hue/Saturation. Lalu sesuaikan Hue menjadi 25. Kemudian terapkan 

adjustment layer hanya ke Screen layer dengan cara Klik Kanan  Create 

Clipping Mask. 

 

Gambar 69. Hasil mengubah warna screen layer dan adjustment layer 

24. Pada titik ini, poster terlihat agak datar. Tujuannya adalah untuk menciptakan 
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ketegangan yang akan mengarahkan pemirsa dari salinan utama ke sisa 

informasi. Ketegangan penting dalam poster karena memberikan fokus dan 

kontras dari elemen lain. Ini juga menciptakan jalur di mana mata harus pergi. 

Sesuatu yang sekecil persegi panjang dapat membuat perbedaan terbesar. 

Kemudian pada panel Tools, pilih Rectangle Tool (U). Klik pada halaman, dan 

atur Width ke 30px dan Height ke 1600px. Kemudian klik OK. Arahkan ke bilah 

Options, dan atur Fill menjadi hitam. Tempatkan persegi panjang secara vertikal 

antara Screen image dan DJ. 

 

 

Gambar 70. Hasil mengubah warna screen layer dan adjustment layer 

25. Agar dapat menggunakan ukuran huruf yang lebih besar, bagi kata Introspektive 

ke dalam dua baris. Selain itu, gunakan lighter weight pada Musik karena hal 

ini merupakan bagian sekunder dari kata utama. Karena ada banyak hal yang 

terjadi secara visual, pilih untuk menyimpan sisa informasi dalam single weight 

dan size. 

Pada panel Tools, pilih Text Tool (T). Gunakan teks putih untuk kontras dengan 

background. Jenis huruf yang digunakan adalah US Bill Sans by Formatika, from 

Envato Elements. Munculkan panel Tools dengan masuk ke 

Type Panels Character Panel. Di bawah ini adalah detail yang saya 

tambahkan “;” setiap titik peluru adalah lapisan terpisah. Gunakan guides yang 

kita buat di awal tutorial untuk menyelaraskan teks. 

INTROS— PEKTIVE 

MUSIK (US Bill in ExtraBold and Light, Size: 120 pt, Leading: 100 pt, 
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Tracking: 200 pt) 

10. — 23. JULI 2019 

FRANKFURT AM MAIN 

02. — 17. OKT 2019 

BERLIN 

06. — 19. JÄN 2020 

MUNCHEN 

(US Bill in Bold, Size: 30 pt, Leading: 40 pt, Tracking: 200 pt) 

MWM.DE (US Bill in Bold, Size: 30 pt, Leading: 40 pt, Tracking: 200 

pt) 

 

Gambar 71. Hasil penggunaan lighter weight 

26. Cara menyimpan file untuk web 

Arahkan ke File Save dan save file seperti biasanya. Untuk save file JPEG 

untuk web, buka File Save for Web atau Shift-Option-Command-S. Di bawah 

Image size, dapat mengubah pixel size gambar jika memiliki size constraints. 

Di sisi kiri bawah, dapat melihat preview ukuran file. Ini berguna ketika ada size 

constraints di situs web dan perlu menurunkan quality atau size image. 

Kemudian Klik Save untuk memilih lokasi di new window, dan klik Save lagi. 
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Gambar 72. Cara save File 
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PORTOFOLIO DARI SOFTWARE GRAFIS BERBASIS       VECTOR 

 

Langkah-langkah penggabungan image kompleks: 

1. Mengatur Halaman 

2. Buka Lembar kerja baru, pada Menu Bar  File  New atau tekan tombol 

Ctrl+N di keyboard. 

3. Pada Menu Bar  Tools  Options (Ctrl+J) untuk membuka tabel Options, 

seperti gambar dibawah ini; 

 

Gambar 73. Tampilan tabel options 

4. Pada jendela sebelah kiri, klik Document  Page Size  pada jendela pafe 

size rubah ukuran kertas menjadi A4, posisi Landscape; 

 

Gambar 74. Cara mengubah paper size 

5. Selanjutnya klik Layout, pada kotak Layout ubah yang tadinya Full Page 
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menjadi Booklet kemudian Klik OK, beri Ceklis pada Facing Pages. 

Gambar 75. Cara merubah layout 

6. Setting diatas hanya ada 1 halaman, agar ada 8 halaman maka harus ditambah 

7 halaman lagi, dengancara pada Menu Bar  klik sub menu Layout  Insert 

Page, isi kolom number of Pages: 7 dan Klik OK 

 

Gambar 76. Cara menambah halaman 

 

 

7. Sehingga lembar kerja kita berubah menjadi ukuran setengah A4 (2 x A5 = A4) 
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Gambar 77. Hasil pengaturan layout 

8. Membuat Paragraph Text 

Buat paragraph text dengan cara pilih Text Tool, kemudian ketik apa saja text 

pada halaman pertama 

Gambar 78. Cara membuat paragraph text 

9. Kemudian klik di dalam Guidlines halaman kedua maka dengan sendirinya 

muncul paragraph text-nya 
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Gambar 79. Cara membuat paragraph text 

10. Memasukan Gambar 

Memasukan gambar dengan cara klik Menu bar File  Import, pilih file 

gambar dan klik import. 

 

Gambar 80. Cara memasukan gambar 

11. Seperti dibawah ini hasil dari import gambar ke lembar kerja untuk 

digabungkan dengan Paragraph Text. 

 

Gambar 81. Hasil memasukan gambar 

12. Hasil seperti diatas potong gambar agar pengaplikasian Wrap paragraph Text 
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lebih menarik 

 

 

Gambar 82. Hasil Pengaplikasian Wrap paragraph Text 

13. Setelah Objek kurva dibuat selanjutnya seleksi object dan klik Intersect pada 

Property Bar 

 

Gambar 83. Hasil Pengaplikasian Wrap paragraph Text 

14. Jika sudah lakukan penyimpanan file dengan memilih menu Bar File  
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Save.as 

Gambar 84. Tampilan simpan 
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15. Atau juga bisa untuk di publish PDF dengan memilih menu bar File  

Publish pdf 

 

Gambar 85. Publish to PDF 
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MENGENAL TOOLS PHOTOSHOP 

 

A. Pengenalan Adobe Photoshop 

Adobe Photoshop atau sering disebut photoshop merupakan software powerfull 

dan optimal yang sangat populer dikalangan desainer grafis. Mulai dari seorang 

pemula hingga mahir, hal ini dikarenakan tampilan yang nyaman dan mudah 

digunakan berbagai toolsnya. 

Adobe Photoshop, atau biasa disebut Photoshop, adalah perangkat lunak editor 

citra buatan Adobe Systems yang dikhususkan untuk pengeditan foto/gambar 

dan pembuatan efek. Perangkat lunak ini banyak digunakan oleh fotografer 

digital dan perusahaan iklan sehingga dianggap sebagai pemimpin pasar 

(market leader) untuk perangkat lunak pengolah gambar/foto, dan, bersama 

Adobe Acrobat, dianggap sebagai produk terbaik yang pernah diproduksi 

oleh Adobe Systems. Versi kedelapan aplikasi ini disebut dengan nama 

Photoshop CS (Creative Suite), versi sembilan disebut Adobe Photoshop CS2, 

versi sepuluh disebut Adobe Photoshop CS3, versi kesebelas adalah Adobe 

Photoshop CS4, versi keduabelas adalah Adobe Photoshop CS5, versi 

(ketigabelas) adalah Adobe Photoshop CS6, dan Versi yang terakhir adalah 

versi (keempat belas) Adobe Photoshop CS7. 

Cara menginstal adobe photoshop langkah-langkahnya bisa kamu cek dibawah 

ini: 
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1. Setelah kamu berhasil mendownload Adobe Photoshop CS6, selanjutnya 

kamu perlu menginstallnya. Pertama-tama ekstrak dulu filenya kemudian 

klik 2X Set-up. 

 

  Gambar 86. Ekstrak file Adobe Photoshop 

 

2. Tunggu beberapa saat sampai jendela awal instalasi terbuka. Selanjutnya 

kamu pilih Install a trial. 

 

 

Gambar 87. Install trial 



Modul Praktikum Desain Grafis 78 
 

3. Pada jendela syarat dan ketentuan, tinggal pilih Accept. 

Gambar 88. Jendela Syarat dan Ketentuan 

 

4. Berhubung disini kita belum punya akun Adobe. Maka terlebih dahulu kita 

harus membuatnya dengan cara memilih Get an Adobe ID. 

 

Gambar 89. Sign In akun Adobe  

 

5. Masukkan informasi tentang diri anda, selanjutnya pilih Sign up. 
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Gambar 90. Sign Up akun Adobe jika belum mempunyai akun 

 

6. Terdapat 2 opsi yakni Adobe Photoshop CS6 (64 Bit) dan Adobe Photoshop 

CS6. Berhubung Windows saya menggunakan 64-Bit, maka saya centang 

Adobe Photoshop CS6 (64 Bit). Selanjutnya klik install 

 

Gambar 91. Pilih Versi Adobe Photoshop 
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7. Tunggu proses instalasi hingga selesai. Lama tidaknya proses ini bergantung 

spesifikasi laptop / komputer masing-masing. 

 

 

Gambar 92. Proses Instalasi  

 

8. Setelah Adobe Photoshop CS6 berhasil diinstall. Selanjutnya tinggal pilih 

Close, selanjutnya perlu mengaktifkannya terlebih dahulu biar tidak Trial. 

Gambar 93. Instalasi Berhasil 

 

9. Untuk melakukan aktivasi pada Adobe Photoshop CS6, terlebih dahulu 
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kamu harus download file ini. Setelah itu kamu ekstrak filenya, akan ada 

2 folder yang bernama 32 Bit dan 64 Bit. Setelah itu anda copy file 

amtlib.dll seperti yang ditunjuk tanda panah. 

 

Gambar 94. Folder Aktivasi  

 

10. Setelah itu anda masuk ke partisi C atau Local Disk (C:) kemudian anda 

pilih Program Files. Loh itu kok ada folder yang bernama Program Files 

(x86)? x86 itu sama dengan 32 Bit, itu berarti folder Program Files (x86) 

berisi aplikasi-aplikasi 32 Bit. 
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Gambar 95. Isi Folder program Files 

 

11. Setelah itu anda masuk ke folder Adobe Photoshop CS6 (64 Bit). 
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    Gambar 96. folder Adobe Photoshop CS6 (64 Bit) 

Pastekan file amtlib.dll tadi dengan menggunakan tombol Ctrl + V. Jika muncul 

notifikasi seperti ini, tinggal pilih Replace the file in the destination. 

 

Gambar 97. Replace file amtlib 

 

12. Pilih Continue untuk melanjutkan. 
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Gambar 98. Notifikasi untuk copy folder 

 

13. Setelah itu coba buka aplikasi Adobe Photoshop CS6-nya 

 

 

   Gambar 99. Tampilan Adobe Photoshop CS6  

Cara Menjalankan Photoshop Jika Sudah Menginstal: 

1. Klik Start 

2. Klik All Program 

3. Klik Adobe Master Collection CS6 
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4. Klik Adobe Photoshop CS6 

 

Gambar100. Cara menjalankan Photoshop 

5. Setelah itu program Adobe Photoshop terbuka 

 

Gambar 101. Tampilan Adobe Photoshop 

A. Komponen Dari Adobe Photoshop: 

1.) Title Bar : Menampilkan nama file yang sedang aktif dan bisa di gunakan untuk 

memindahkan posisi jendela photoshop pada dekstop. 

2.) Menu Bar : Berisi deretan menu yang meliputi : File, Edit, Image, Layer, Select, 

Filter, View, Windows, Help. Dalam menu bar terdapat bebrapa perintah pada 

apa yang sedang kita edit atau kerjakan. Menu - menu yang terdapat pada adobe 
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photoshop adalah sebagai berikut : 

a. File : Berisi menyimpan file, membuka file, export file, import file, cetak 

file, page setup dan sebagainya yang memiliki fungsi tersendiri. 

b. Edit : Berisi semua yang berhubungan dengan editing seperti, cut, copy, 

paste, undo, step forward, step backward, keyboard shotcut, transform, dll. 

c. Image : kumpulan menu yang berfungsi sebagai mengatur gambar, seperti 

warna, size dukumen dan image, dll. Beberapa pilihan juga memiliki sub 

menu yang fungsinya berbeda - beda. 

d. Layer : Kumpulan menu yang berhubungan denga layer pada gambar yang 

berfungsi sebagai mengatur layer, seperti menambah layer, menghapus layer, 

membuat masing , dll. 

e. Select : Semua yang berhubungan denga menyeleksi gambar, seperti 

menghapus seleksi, seleksi ulang, dll. 

f. Filter : berisikan menu - menu efek yang akan kita berikan pada objek 

yang sedang kita edit.pilihan efek disini cukup banyak jadi sobat bisa coba 

- coba semua efek tersebut. Kamu juga bisa mengkombinasikan satu efek 

dengan efek yang lainnya. 

g. View : Digunakan untuk mengatur pandangan kita juga bisa mengatur jenis 

tampilan dokumen window seperti, snap, show, dll. 

h. Window : Digunakan untuk menamnpilkan window kerja seperti 

menampilkan Arrange, Workspace, dll. 

i. Help : berisi tentang semua bantuan - bantuan yang telah disediakan oleh 

adobe photoshop, jika sobat masih ada yang kurang jelas tentang isi adobe 

photoshop 

3.) Ruler : Atau yang disebut juga penggaris yang berguna untuk menentukan 

posisi serta ukuran suatu objek. 

4.) Drawing Windows : Daerah yang digunakan sebagai lembar kerja untuk 

berkreasi dengan foto atau gambar. 

5.) Toolbox : Komponen yang digunakan untuk memberikan akses perintah ke 

photoshop. 

6.) Pallete : Komponen ini digunakan untuk memilih dan mengatur berbagai 

parameter. Pallete sangat berguna pada saat kita melakukan editing, dengan pallete 

kita menggunakan beberapa menu pilhan tanpa harus melalui menu bar. Misalnya 



Modul Praktikum Desain Grafis 87 
 

pada pallete layer, gambar yang di edit lebih dari satu layer, setiap layer bisa di 

format sendiri -sendiri, atau setiap layer memiliki efek berbeda, dan susunan 

layer dapat di atur sesuai kebutuhan kita, pallete dalam Adobe Photoshop CS3 tidak 

jauh berbeda dengan versi Adobe Photoshop sebelumnya. 7.) Sizing Button : 

Tombol ukuran yang berada pada kanan atas jendela Photoshop. 8.) Dock Of Panels 

Collapese to icon : Kumpulan suatu tool dalam sebuah panel 

yang tergroup menjadi sebuah ikon tools. 
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TOOLS-TOOLS SELECTION 

 

1. Layer 

Fungsi palet layer adalah untuk mengedit (membuat, mengcopy, menempelkan, 

menghapus) dan menggunakan Mask Layer. 

Layer adalah lapisan yang berfungsi sebagai tempat objek, bisa ibaratkan sebagai 

kanvas atau lapisan atau sebuah element yang ada pada aplikasi Photoshop yang 

dapat gunakan untuk gabungkan beberapa gambar menjadi satu gambar. 

Layer sangat penting dalam pembuatan sebuah desain, jika kita ingin 

menambahkan atau membuat sebuah desain. Kamu juga dapat mengatur 

komposisi layers dengan cara mengubah atribut dan urutan layers, artinya 

beberapa gambar tersebut menyatukan sehingga akan terlihat menjadi sebuah 

objek atau gambar. Dengan adanya Layers, memungkinkan kamu untuk edit 

sebuah objek tanpa mengganggu objek yang lain. 

Sebagai contoh, jika kamu sedang edit gambar A maka gambar B tidak akan 

terpengaruh. 
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▪ Link 

Gambar 102. Layers 

Berfungsi untuk membuat agar bisa mengelompokkan banyak layer sekaligus. 

Cara memakainya dengan memilih nama-nama layer yang diinginkan (dengan 

Shift + Klik), kemudian klik icon ini. 

▪ Layer Style 

Berfungsi untuk membuat layer yang berfungsi seperti menu Layer > Layer style. 

▪ Add Layer Mask 

Untuk menutup/melindungi sebagian/seluruh lapisan gambar dari proses 

pengeditan. 

▪ New Adjustment Layer 

Untuk membuat layer yang berfungsi sebagai pengubahan warna. Perbedaannya 

kalau menggunakan menu Image > Adjustment bisa dibaca artikel tutorial yang 

ini. 
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▪ Layer Group 

Untuk mengelompokkan beberapa layer menjadi suatu kumpulan layer, agar 

mempermudah proses pekerjaan yang menggunakan banyak sekali layer. 

▪ New Layer 

Untuk membuat layer baru yang kosong, ataupun untuk membuat duplikat layer. 

Untuk membuat duplikat layer, lakukan dengan cara menggeser nama layer ke 

icon ini. 

▪ Delete Layer 

Untuk menghapus Layer. Aktifkan layer yang ingin kamu hapus, kemudian klik 

icon ini. Dalam Photoshop versi CS2, bisa juga dilakukan hanya dengan 

mengaktifkan layer kemudian tekan tombol Delete pada keyboard (ini belum bisa 

dilakukan jika kamu menggunakan Photoshop versi sebelumnya). 

▪ Layer Bleding Option 

Untuk mengatur proses yang terjadi pada pixel-pixel layer terhadap layer yang ada 

posisinya berada pada bawahnya. 

▪ Image Adjustment Layer 

Menunjukan sebuah gambar Layer yang merupakan pada pengaturan warna. 

▪ Layer Thumbnail 

Adalah tampilan gambar kecil dari gambar asli kamu. Jika layer merupakan 

sebuah tulisan atau text, maka gambar tampilannya adalah sebuah huruf T. 
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2. Channel 

Channel : berfungsi untuk menyimpan informasi warna yang dapat dipisahkan 

dalam beberapa warna. Panel Channels berfungsi untuk menyimpan informasi 

mengenai warna yang berlaku pada gambar yang sedang kita kerjakan. Dan 

menggunakan Channels Sobat dapat menyeleksi gambar berdasarkan warna. 

Fasilitas panel Channels memungkin Sobat untuk membuat Channel baru, 

menggandakan Channel dan beberapa perintah lain. 

 

 

Gambar 103. Edit Channel 

 

channel dalam bahasa indonesia disebut "saluran/bagian" adalah salah satu menu 

didalam program adobe photoshop untuk pembagian warna- warna. kalau 

diibaratkan seorang pelukis kaca, channel merupakan lapisan kaca-kaca yang dapat 

kita warna satu persatu sebagai lukisan. sebagai contoh anda dapat membuka file 

image yang berupa warna CMYK. warna tersebut terdiri dari empat bagian channel 

yang masing- masing channelnya mempunyai pemisahan warna diantaranya 

channel 1 warna cyan (biru), channel 2 warna magenta (merah), channel 3 warna 

yellow (kuning), dan channel 4 warna black (hitam)  untuk membuka 
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channel anda dapat membuka pallet channel dengan cara pilih dan klik menu 

window - channel. 

keterangan pallet channel: 

 

load channel as selection : untuk membuat seleksi pada channel 

save selection as channel : untuk menyimpan seleksi pada channel 

create new channel : untuk membuat channel baru 

delete current channel : untuk menghapus channel 

 

channel menu : tombol segitiga berisi menu-menu channel 

diantaranya yaitu: 

- dock to palette wall : untuk meletakkan kedalam palette wall 

- new channel : untuk membuat channel baru 

- duplicat channel : untuk membuat channel duplikat 

- delete channel : untuk menghapus channel 

- new spot channel : untuk membuat channel spot baru 

- merge spot channel : untuk menggabungkan channel channel spot 

- channel options : untuk mengoperasikan channel 

- split channel : untuk memisahkan channel 

- merge channel : untuk menggabungkan channel yang di split 

- pallet options : untuk mengoperasikan pallete channel 

 

3. Path 

PATH : garis atau kurva yang dapat digambardengan icon Pen Tool, fungsinya 

untuk menandai daerah yang sedang diedit, untuk menyimpan mask (layer mask) 

yang sederhana. 

Path Selection Tool merupakan sebuah Tools yang digunakan pad Photoshop 

untuk menyeleksi semua objek yang pada dasarnya dibuat menggunakan mode 

Shape atau pun Path. Objek yang dibuat menggunakan Mode Shape dan Path pasti 

terdapat Anchor dan Path dari bagian- bagiannya. 

Path Selection Tool, sesuai dengan namanya, Digunakan untuk memindahkan Path 

yang ada pada Object Shape dan Object Path tersebut. Dengan begitu, kita bisa 

saja membuat Objek (misalnya berupa Shape) lebih dari satu dalam sebuah layer, 
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dan memindahkan objek-objek tersebut dengan menggunakan Path Selection 

Tool. 

B. Pengenalan Tools pada Photoshop 

 

Gambar 104. Pengenalan Tools 

a. Marquee Tool 

 

Gambar 105. Marquee Tool 

 

Marquee Tool berfungsi untuk menyeleksi objek. Marquee Tool dibagi menjadi 4, 

yaitu: 

1. Rectangular Marquee Tool (shortcut keyboard: M), berfungsi untuk 

menyeleksi objek berbentuk kotak/segiempat. 

2. Elliptical Marquee Tool (shortcut keyboard: M), berfungsi untuk 

menyeleksi objek berbentuk lingkaran/elips. 

3. Single Row Marquee Tool, berfungsi untuk menyeleksi objek dengan garis 

horizontal. 

4. Single Column Marquee Tool, berfungsi untuk menyeleksi objek dengan 
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garis vertikal. 

Dan pada pengaturannya kita dapat mengeluarkan Option pada menu window, 

berikut tampilannya. 

 

 

b. Lasso Tool 

 

Gambar 106. Lasso Tool 

 

Lasso Tool juga berfungsi untuk menyeleksi objek, tetapi dalam bentuk yang 

bebas. Lasso Tool dibagi menjadi 3, yaitu: 

 

1. Lasso Tool (shortcut keyboard: L), berfungsi untuk menyeleksi objek 

dalam bentuk bebas sesuai keinginan. 

2. Polygonal Lasso Tool (shortcut keyboard: L), berfungsi untuk menyeleksi 

objek dalam bentuk garis-garis bebas. 

3. Magnetic Lasso Tool (shortcut keyboard: L), menyeleksi objek dengan 

garis yang otomatis menempel pada objek yang diseleksi. 

Dan pada pengaturannya kita dapat mengeluarkan Option pada menu window, 

berikut tampilannya dengan menggunakan Polygonal Lasso Tool. 

 

 

Gambar 107. Polygonal Lasso Tool 

 

 

 

 

c. Quick Selection & Magic Wand Tool 
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Gambar 108. Quic Selection & Magic Tool 

 

Magic Wand Tool (W), Untuk menyeleksi gambar yang memiliki warna sama 

 

1. Quick Selection Tool (shortcut keyboard: W), berfungsi untuk menyeleksi area 

secara bebas berdasarkan warna atau pixel. 

2. Magic Wand Tool (shortcut keyboard: W), berfungsi untuk menyeleksi objek 

berdasarkan warna yang sama. 

Perbedaan toleransi warna dapat diatur pada tool option bar, kita dapat 

mengeluarkan Option pada menu window, berikut tampilannya dengan 

menggunakan Magic Wand Tool. 

 

 

Gambar 109. Wand Tool 

d. Crop & Slice Tool 

 

Gambar 110. Crop & Slice Tool 

 

1. Crop Tool (shortcut keyboard: C), berfungsi untuk memotong gambar 

dengan bentuk kotak/segiempat. 

2. Slice Tool (shortcut keyboard: C), berfungsi untuk memotong gambar 

menjadi beberapa bagian. 

3. Slice Select Tool (shotcut keyboard: C), berfungsi untuk memotong gambar 

dari potongan Slice Tool. 

e. Eyedropper, Color Sample, Ruler, and Note Tool 
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Gambar 111. Eyedropper, color,sample,Rulerand Note 

 

1. Eyedropper Tool (shortcut keyboard: I), berfungsi untuk mengambil 

sampel warna. 

2. Color Sample Tool (shortcut keyboard: I), berfungsi untuk sampel warna 

dari beberapa titik. 

3. Ruler Tool (shortcut keyboard: I), berfungsi untuk mengukur jarak dari 2 

titik yang telah dipilih pada gambar. 

4. Note Tool (sortcut keyboard: I), berfungsi untuk membuat catatan pada 

gambar. 

f. Healing Brush & Patch Tool 

 

Gambar 112. Healing Brush & Patch Tool 

 

1. Spot Healing Brush Tool (shortcut keyboard: J), berfungsi untuk 

menyamarkan atau menghilangkan noda-noda di gambar. 

2. Healing Brush Tool (shortcut keyboard: J), juga berfungsi untuk 

menyamarkan atau menghilangkan noda-noda di gambar, tetapi kita 

harus mengambil sampel warna terlebih dahulu. 

3. Patch Tool (shortcut keyboard: J), berfungsi untuk menyamarkan atau 

menghilangkan noda-noda di gambar dengan cara menyeleksi area 

kemudian menyeretnya ke bagian gambar yang bersih. 

4. Red Eye Tool (shortcut keyboard: J), berfungsi untuk menghilangkan 
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warna merah pada mata. 

 

g. Brush & Pencil Tool 

 

Gambar 113. Brush & Pencil Tool 

 

1. Brush Tool (shortcut keyboard: B), berfungsi untuk mewarnai gambar 

dengan efek sapuan kuas. 

2. Pencil Tool (shortcut keyboard: B), berfungsi untuk mewarnai gambar 

dengan efek goresan pensil. 

3. Color Replacement Tool (shortcut keyboard: B), berfungsi untuk 

mengganti warna gambar. 

4. Mixer Brush Tool (shortcut keyboard: B), berfungsi untuk mencampur 

warna dalam sikat stroke tunggal. 

h. Stamp Tool 

 

Gambar 114. Stamp Tool 

1. Clone Stamp Tool (shortcut keyboard: S), berfungsi untuk menyalin pola 

gambar yang sudah dipilih, kemudian menimpanya ke gambar lain. 

2. Pattern Stamp Tool (shortcut keyboard: S), berfungsi untuk memberi 

tekstur pada gambar. 
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i. History Brush Tool 

 

Gambar 115. Brush Tool 

1. History Brush Tool (shortcut keyboard: Y), berfungsi untuk menampilkan semua 

rekaman perintah Brush Tool. 

2. Art History Brush Tool (shortcut keyboard: Y), berfungsi untuk menampilkan 

semua rekaman perintah Brush Tool yang diberi style art. 

j. Eraser Tool 

 

Gambar 116. Eraser Tool 

 

1. Eraser Tool (shortcut keyboard: E), berfungsi untuk menghapus layer/objek. 

2. Background Eraser Tool (shortcut keyboard: E), berfungsi untuk menghapus 

background menjadi transparan. 

3. Magic Eraser Tool ( shortcut keyboard:E ), berfungsi untuk                     menghapus warna 

dominan yang telah kita pilih. 

k. Gradient & Paint Bucket Tool 

 

Gambar 117. Gradient & Paint Bucket Tool 

 

1. Gradient Tool (shortcut keyboard: G), berfungsi untuk membuat 

gradasi warna. 

2. Paint Bucket Tool (shortcut keyboard: G), berfungsi untuk membuat 
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warna sesuai dengan warna Foreground. 

l. Blur, Sharpen, and Smudge Tool 

 

 

Gambar 118. Blur, Sharpen and Smudge Tool 

 

1. Blur Tool, berfungsi untuk mengaburkan/memberi efek blur pada gambar. 

2. Sharpen Tool, berfungsi untuk menajamkan gambar. 

3. Smudge Tool, berfungsi untuk memberikan efek lukisan seperti cat basah 

pada gambar. 

m. Dodge, Burn, and Sponge Tool 

 

 

Gambar 119. Dodge, Burn and Spage Tool 

 

1. Dodge Tool (shortcut keyborad: O), berfungsi untuk memperterang warna 

gambar. 

2. Burn Tool (shortcut keyborad: O), berfungsi untuk menggelapkan warna 

gambar. 

3. Sponge Tool (shortcut keyboard: O), berfungsi untuk menguatkan atau 

mengurangi warna. 
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n. Pen & Point Tool 

 

 

 

Gambar 120. Pen & Point Tool 

 

1. Pen Tool (shortcut keyboard: P), berfungsi untuk membuat garis path, 

vektor, ataupun mask pada gambar. 

2. Freeform Pen Tool (shortcut keyboard: P), berfungsi untuk membuat garis 

path, vektor, ataupun mask dengan bentuk bebas pada gambar. 

3. Add Anchor Point Tool, berfungsi untuk menambahkan titik anchor yang 

berfungsi untuk mengedit garis path. 

4. Delete Anchor Point Tool, berfungsi untuk menghapus titik anchor pada 

garis path. 

5. Convert Point Tool, berfungsi untuk mengubah garis path dengan cara 

menggeser titik anchor. 

o. Type/Text Tool 

 

Gambar 121. Type/Text Tool 

 

1. Horizontal Type Tool (shortcut keyboard: T), berfungsi untuk membuat 

teks secara horizontal pada gambar. 
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2. Vertical Type Tool (shortcut keyboard: T), berfungsi untuk membuat teks 

secara vertikal pada gambar. 

3. Horizontal Type Mask Tool (shortcut keyboard: T), berfungsi untuk 

membuat seleksi dengan bentuk teks secara horizontal. 

4. Vertical Type Mask Tool (shortcut keyboard: T), berfungsi untuk 

membuat seleksi dengan bentuk teks secara vertikal. 

p. Path & Direct Selection Tool 

 

 

Gambar 122. Path & Direct Selection Tool 

 

1. Path Selection Tool (shortcut keyboard: A), berfungsi untuk menggeser 

objek path. 

2. Direct Selection Tool (shortcut keyboard: A), berfungsi untuk menggeser 

titik anchor untuk melakukan pengubahan pada bentuk path. 

q. Shapes Tool 

 

 

Gambar 123. Shapes Tool 

 

1. Rectangle Tool (shortcut keyboard: U), berfungsi untuk membuat objek 

berbentuk segi empat. 
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2. Rounded Rectangle Tool (shortcut keyboard: U), berfungsi untuk 

membuat objek berbentuk segi empat dengan sudut melengkung. 

3. Ellipse Tool (shortcut keyboard: U), berfungsi untuk membuat objek 

berbentuk lingkaran. 

4. Polygon Tool (shortcut keyboard: U), berfungsi untuk membuat objek 

berbentuk segi banyak. 

5. Line Tool (shortcut keyboard: U), berfungsi untuk membuat objek 

berbentuk garis. 

6. Custom Shape Tool (shortcut keyboard: U), berfungsi untuk membuat 

objek dengan berbagai bentuk yang telah disediakan di option bar. 

r. Hand & Rotate Tool 

 

 

Gambar 124. Hand & Rotate Tool 

 

1. Hand Tool (shortcut keyboard: H), berfungsi untuk menggeser  bidang 

kanvas. 

2. Rotate View Tool (shortcut keyboard: R), berfungsi untuk melihat gambar 

dengan cara memutarnya. 

s. Zoom Tool 

 

 

Gambar 125. Zoom 

 

Zoom Tool (shortcut keyboard: Z), berfungsi untuk memperbesar atau 

memperkecil gambar. 
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t. Set Foreground & Background Color 

 

 

Gambar 126. Set Foreground & Background. 

 

Set Foreground & Background Color, berfungsi untuk mengatur warna 

foreground                     dan background. 

Foreground : Berfungsi untuk menentukan warna depan 

Background : Berfungsi untuk menentukan warna 

belakang 

u. Edit in Quick Mask Mode 

 

 

Gambar 127. Contoh Lasso Tool 

 

Edit in Quick Mask Mode, berfungsi untuk menyeleksi dengan cara 

memisahkannya dengan latar belakang gambar. 
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BERKERJA DENGAN EFFECT 

 

Filter adalah main menu pada progam aplikasi Adobe Photoshop. Ada beberapa 

jenis aplikasi filter yang ada pada Adobe Photoshop, sebagai berikut: 

1. Extract 

Yaitu sebuah submenu yang terdapat pada menu Filter yang berfungsi untuk 

mengambil obyek yang diinginkan sesuai dengan kebutuhan Anda. 

Cara penggunaannya: 

1. Klik menu Filter pilih Extract. 

2. Klik Edge Highlighters Tools. 

3. Seleksi obyek tersebut. 

4. Setelah terseleksi klik Fill Tool maka akan berubah warna seleksinya. 

5. Lalu untuk mengambil hasilnya Anda Klik Preview 

Bila ingin memperbaiki obyek tersebut, Anda bisa gunakan tools yang disediakan 

seperti Eraser, Cleanup, Edge Touchup dan pada Properti sebelah kanan. 

 

2. Liquify 

Filter Liquify digunakan untuk memanipulasi sebuah obyek yang bentuknya bisa 

dirancang sendiri sesuai dengan keinginan sehingga obyek yang anda kehendaki 

sesuai. Sedangkan Liquify merupakan sub menu dari menu Filter. 

Dengan filter - liquify anda dapat merekayasa foto anda dengan mudah, salah satu 

bentuk rekayasa yang disediakan adalah merubah mata sipit menjadi besar dan 

sebaliknya, merubah hidung pesek atau kecil menjadi mancung atau besar, 

merubah pipi kurus menjadi tembem/gemuk dan berbagai macam rekayasa 

lainnya. Jika anda tertarik untuk merekayasa foto anda, berikut saya jelaskan 

sedikit cara kerjanya : 

Dalam kotak dialog liquify anda akan menemui beberapa tools, diantaranya 

sebagai berikut, oh ya sebelumnnya jangan lupa file gambarnya udah siap (file- 

open), setelah udah terbuka filenya, anda klik menu Filter dan pilih lagi sub menu 

Liquify, setelah itu silahkan dipelajari fungsi toolsnya. 

Tool-tool yang terdapat pada Liquify seperti : 
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1. Wrap Tools. 

Digunakan untuk membuat obyek agar terlihat melengkung sesuai dengan 

mouse yang kita drag. 

2. Turbulence Tools. 

Digunakan untuk membuat obyek agar terlihat bergelombang sesuai dengan 

mouse yang kita drag. 

3. Twirl Clockwise Tools. 

Digunakan untuk membuat obyek agar terlihat berputar sesuai searah jarum 

sesuai dengan mouse yang kita drag. 

4. Twirl Counter Clockwise Tools. 

Digunakan untuk membuat obyek agar terlihat berputar sesuai berlawanan 

arah jarum sesuai dengan mouse yang kita drag. 

5. Pucker Tools. 

Digunakan untuk membuat obyek agar terlihat kecil atau kurus sesuai dengan 

mouse yang kita drag. 

6. Bloat Tools. 

Digunakan untuk membuat obyek agar terlihat besar dan beisi sesuai dengan 

mouse yang kita drag.Selain itu Anda dapat menggunakan Properti yang ada 

disebelah kanan sebagai tambahan atau mengatur besar kecilnya ukuran 

brush. 

 

3. Pattern Maker 

Filter Pattern Maker digunakan bila Anda ingin menggunakan warna Pattern 

yang buatan sendiri sehingga obyeknya bisa dipilih sesuai dengan keinginan. 

Dan pada Pattern Maker ini anda bisa membuat Pattren lebih dari satu sehingga 

bila ingin digunakan bisa tinggal Anda pilih sesuai dengan keinginan. 

Cara membuat Pattern Maker yaitu: 

1. Klik menu Filter pilih Pattern Maker. 

2. Aktifkan Tectangle Marquee 

3. Drag obyek yang dikehendaki 
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4. Setelah itu klik Generate, bila ingin lebih dari satu Anda bisa klik Generate 

secara berulang. Dan hasilnya akan terlihat dibawah. 

 

4. Filter – Artistic 

Filter Artistic memberi effect untuk merubah gambar menjadi seperti 

lukisan.Didalam filter artistic disediakan berbagai pilihan. Sebagai contoh kita 

gunakanfilter colored pencil, filter ini berfungsi untuk mengubah gambar 

menjadi sepertigambar yang dibuat dari arsiran pensil warna. 

Filter Artistik 

  --> fungsinya sih buat ciptain kesan artistik pada foto ato objek. 

1. buka file gambarnya. 

2. pilih menu filter > artistik trus pilih salah satu filter yang ada di 

submenu artistik tinggal atur deh setting'nya kayak yang kamu inginkan. 

 

3. Filter – Blur 

Blur sesuai dengan artinya digunakan untuk mengaburkan gambar. Filter ini 

adalah salah satu filter yang paling sering digunakan didalam membuat desain. 

Didalam filter blur disediakan 4 pilihan utama yaitu gaussian, motion, radial dan 

smart. 

Filter blur 

--> fungi dari filter ini buat mengaburkan ato ciptain efek kabur pada gambar di 

kanvas. biasanya sih para tukang foto ato klo bahasa jaman sekarangnya kita 

panggil fotografer sering pake fitur dari filter blur ini. 

1. buka dulu file gambarnya 

2. trus pilih menu filter > blur trus pilih salah satu filter dari keluarga blur yang 

ada 

3. Atur settingnya sesuai yang kalian inginkan. 

 

4. Filter Brush Strokes 

Strokes Fungsi dari filter brush stroke hampir sama dengan filter artistic yaitu 

memberikan efek pada gambar menjadi seperti lukisan dengan berbagai 
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pilihan alat untuk melukis. Filter dalam keluarga Brush Stroke ini berguna 

untuk menciptakan efek sapuan kuas, pensil, atau pena pada garis- garis tepi 

objek sehingga memunculkan kesan lukisan yang artistik. Jika Anda ingin 

mengubah foto Anda menjadi berkesan seperti sebuah lukisan, filter-filter 

dalam kelompok ini juga dapat dijadikan sebagai alternatif pilihan selain 

memanfaatkan filter Artistic. 

 

5. Filter – Distort 

Filter ini berfungsi untuk mengacak gambar dengan suatu keteraturan 

tertentu.Misalkan gambar dibuat bergelombang atau membentuk seperti zig- 

zag. 

Filter Distort 

--> fungsinya buat ciptain efek distorsi ato ngubah orientasi foto atau gambar. 

Stepnya tinggal pilih menu filter > distort , truz tinggal klik salah satu 

pilihannya 

 

6. Filter Noise 

Filter noise digunakan untuk memberikan gangguan pada gambar, misalkan 

diberikan gangguan bintik bintik disekitar gambar. Filter Noise fungsinya 

buat captain efek noise ato kesan kotor ato bintik-bintik di gambar. Tinggal 

pilih aja menu filter > noise. 

 

7. Filter Render 

Fungsinya buat captain efek special yang gk bias diakomodasi filter 

kelompok lain. Anggotanya ada lima clouds >> buat captain tekstur di kanvas 

sehingga jika ada foto , seluruh foto akan tertutup oleh tekstir ini, kecuali kalo 

kamu menurunkan intensitas filternya. 

Difference clouds >> buat beriin efek baying-bayang kabut. 

Fibers >> sama aja kayak clouds, tapi tampilannya bakalan kayak fiber 

(serat). 

Lens flare >> buat beriin efek pantulan cahaya di lensa kamera. 

Lighting effect >> buat ngatur pencahayaan. 
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Nah klo cara pilih filternya , tinggal pilih menu filter > render. 

 

8. Filter – Pixelate 

Filter pixelate digunakan untuk memanipulasi pixel pixel dari suatu gambar. 

Seperti telah dijelaskan sebelumnya bahwa gambar terdiridari titik titik kecil 

atau pixel. fungsinya untuk menciptakan efek nuansa bintik2- bintik atau 

permainan dalam kreasi titik2.caranya : Filter > pixelate truz pilih salah satu 

anggota keluarganya. 

 

Latihan Membuat Poster 

Membuat Poster – Poster merupakan sebuah karya seni yang berfungsi 

sebagai media publikasi untuk memberikan informasi, promosi, iklan, atau 

pengumuman kepada banyak orang dalam bentuk gambar dan tulisan. Dengan 

tujuan mencari perhatian sebanyak mungkin, poster harus dipasang di tempat yang 

ramai agar bisa dibaca oleh banyak orang. Namun, dengan perkembangan 

teknologi, banyak poster yang diposting di sosial media untuk penyebaran 

informasi yang lebih efektif. 

Desain dan tulisan poster seringkali menarik perhatian, gambar yang ciamik 

dengan font yang unik seringkali menarik perhatian mata. Ternyata cara 

membuatnya tidak sulit, lho. 

Saat membuat poster kamu bisa menyalurkan ide dan membuat desain 

semenarik mungkin. Untuk kamu yang masih bingung dalam membuat poster, 

simak cara-cara praktis berikut ini : 
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Cara Membuat Poster di Photoshop 

 

 

Gambar 128. Contoh Poster  

Adobe Photoshop merupakan software yang digunakan untuk pengeditan gambar, 

desain grafis dan seni digital. Cara membuat poster di Photoshop tidak begitu sulit, 

hal ini bisa dilakukan oleh pemula yang masih awam tentang aplikasi pengeditan 

foto. Untuk lebih jelasnya, simak langkah-langkah berikut ini : 

- Membuat Lembar Kerja 

Hal pertama yang kamu bisa lakukan sebelum membuat poster adalah 

menambahkan lembar kerja baru dengan menekan tombol CTRL + N atau klik 

File dan pilih New. 

 

- Atur Ukuran Poster 

Selanjutnya yang kamu perlukan adalah menentukan ukuran poster sesuai 

dengan jenis poster ingin yang ingin kamu buat. Saat membuat lembar kerja, 

kamu akan diminta untuk mengisi beberapa detail seperti nama, preset, ukuran 

kertas, width, height, resolution, color mode, dan background content. 

 

- Siapkan Gambar Ilustrasi Poster 

Kamu harus mempersiapkan gambar ilustrasi yang akan digunakan untuk 

background poster. Gambar disesuaikan dengan konteks poster yang akan dibuat. 

Contohnya, jika kamu ingin membuat poster film perang, maka siapkan gambar 

orang memegang senjata dan sejenisnya. 

https://www.tokopedia.com/jasa/print/kebutuhan-promosi/poster-standar
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- Buat Warna Background Poster 

Background poster memiliki warna yang bisa disesuaikan dengan tema 

poster. Untuk mengaturnya, pilih Set Foreground. Pada kotak warna yang tersedia, 

pilih warna lalu klik OK. 

Setelah itu, warna poster akan berubah dan hilangkan garis yang terdapat di kertas 

warna poster dengan menekan Alt+Delete. 

 

- Buat Shape Persegi Panjang 

Poster biasanya hadir dalam bentuk persegi panjang. Untuk membuat 

persegi panjang dalam Photoshop, kamu perlu klik kanan Rectangle Tool yang 

berada di bagian kiri Photoshop dengan ikon persegi atau kotak. 

Pilih Rectangle Tool, lalu klik lembar kerja untuk mengaktifkan fitur tersebut. 

Ukuran dan warna persegi dapat disesuaikan dengan poster. 

 

- Shape Lingkaran 

Selain persegi Panjang, kamu juga bisa membuat poster semakin menarik 

dengan shape lingkaran. Caranya, klik kanan Rectangle Tool yang ada di bagian 

kiri Photoshop, lalu pilih Eclipse Tool untuk membuat lingkaran. 

 

- Tambahkan Gambar Ilustrasi dan Tulisan 

Setelah     membuat background poster     dengan      berbagai      warna dan 

shape. Masukkan gambar ilustrasi agar poster semakin menarik. Caranya klik File 

dan pilih Open. Pilih gambar ilustrasi yang diinginkan dan sesuaikan posisinya 

dengan poster. 

Setelah itu, tambahkan tulisan poster dengan pilih menu Type yang ada di bagian 

kiri Photoshop dengan ikon huruf T. Lalu, pilih jenis tulisan yang ingin dibuat 

sekreatif mungkin. 

Terakhir, simpan poster di penyimpanan laptop atau PC kamu. Selesai! 

  

https://www.tokopedia.com/p/komputer-laptop/laptop
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Media Promosi lainnya 

 

 

 

Gambar 129. Contoh Media Promosi
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OLAHAN FONT DAN EFEKNYA 

 

A. Teks Alien 

1. Buka file dengan ukuran 300 x 200 pixel dan warnai background dengan 

warna hitam, buat layer baru kemudian dengan menggunakan teks tool 

kita buat tulisan. 

2. Kemudian dengan masih terpilihnya teks, pilih menu Filter, pilih Blur, 

lalu pilih Radial Blur dan isikan Amount = 100, Blur Method = Zoom, 

Quality = Best. 

3. Lakukan Efek Blur sekali lagi atau menekan tombol Shift + F. 

 

 

 

 

B. Gambar 130. Blur Effect 
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B. Matrix Text 

a. Set #003100 (Dark green) sebagai foreground color. Gunakan text tool 

lalu ketik tulisan Matrix Text, Font = Arial Black, Size = 36pt. 

Gambar 131. Contoh Dark Green 

b. Klik Filter > Blur > Gaussian blur dan klik ok saat muncul pilihan 

rasterizing the layer. Set radius = 1. 

 

Gambar 132. Contoh Gausian Blurr 

c. Setelah itu klik Filter > Distort > Ocean ripple ubah Ripple size= 5, 

Ripple Magnitude= 10 

 

 

Gambar 133. Contoh Gausian Blurr 

 

d. Duplicate layer lalu klik Filter > Sketch > Water paper rubah Fiber 

length = 42, Brightness = 70, Contrast: 64 

 

 

Gambar 134. Contoh Filter Sketch 

e. Pada layers toolbar pilih blend mode = Hardlight, Merge kedua layer 

layers (Ctrl+E). 

 

Gambar 135. Contoh blend mode 

f. Duplicate layer lalu klik Filter > Blur > Motion Blur lalu klik Angle: 

90, Distance: 33, pilih blend mode = Hardlight. 
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C. Membuat Teks Bayangan

 

a. Buka file dengan ukuran 300 x 200 px, ketik teks yang diinginkan. 

b. Buat duplikasi teks kita dengan cara klik kanan pada layer, pilih 

Duplicate Layer dan beri nama duplikat layer tesebut. 

c. Kemudian duplikat layer tersebut kita modifikasi, caranya pilih menu 

Edit, Transform, Flip Vertical. 

d. Kemudian kita geser duplikat teks kebawah dengan cara menekan Shift 

+ Kursor kebawah. 

 

 

 

 

D. Green Gel Text 

Gambar 136. Contoh Teks Bayangan 

a. Buka dokumen baru dengan ukuran 500 X 250, menggunakan text tool 

ketik tulisan green font = George, Size = 150. 

 

Gambar 137. Contoh Green Front 
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b. Buka Character Menu, klik Window > Character, rubah ‘A V’ = - 120. 

 

 

 

 

 

 

 

Gambar 138. Contoh character menu 

c. Klik menu Layer > Layer Style lalu plih Drop Shadow, ubah Blend mode 

= Multiply, Opacity = 42, Angel = 120o, Distance = 0px, Spread = 

24%, Size = 9px.Gambar1.70 Contoh Layer Style 

Gambar 139. Menu Layer Style 

d. Lalu pilih Inner Glow pada Layer Style menu, lalu ubah Blend mode 

= Screen, Opacity = 74%, Technique = Softer, Source = Edge, 

Choke = 45%, Size = 3px, Range = 50%. 

 

 

 

 

 

 

 

Gambar 140. Contoh inner Glow 
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e. Select Bevel and Emboss pada Layer Style menu lalu ubah, Style = Inner 

Bevel, Technique = Smoot, Depth = 103, Direction = Up, Size 

= 8px, Angel = 120o, Altitude = 30o, Gloss Contour = Rounded Steps, 

Highlight mode = Normal, Opacity = 100%, Shadow mode = Normal-

hijau, Opacity = 100%, filltype = Color, Color = Hijau. 

Gambar 141. Contoh Embos 

 

f. Selanjutnya pilih Gradient Overlay pada Layer Style menu lalu ubah, 

Blend Mode = Normal, Opacity = 100%, Style = Linear, Angel = 90o, 

Scale = 47%. 

 

 

Gambar 142. Contoh Gradient 
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g. Hasilnya seperti dibawah ini. 

 

 

 

E. Efek Hulk 

Gambar 143. Contoh Hasil 

a. Buat file baru, ukuran kanvas : 6 x 2 Inchi dengan resolusi 72 

pixel/inchi. 

b. Aktifkan Text Tool, kemudian ketikkan teks pada kanvas, pilih jenis 

font, ukuran dan warna teks. 

 

 

Gambar 144. Efek Hulk 
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c. Pada palet layer, Klik kanan layer teks lalu pilih Blending Options (atau 

dapat dilakukan dengan klik ganda) sehingga terbuka kotak dialog 

Blending Option. Pilih Stroke pada Styles. 

 

 

Gambar 145. Stroke pada Styles 

 

d. Pertama kita akan member tipe warna (Fill type) yang akan diberikan 

pada teks. Penulis memilih Gradient dan pada pilihan gradient penulis 

memilih Orange Yellow Orange. 

 

 

 

 

 

 

 

 

Gambar 146. Contoh Fill Type 

 

e. Jika warna ini kurang menarik, anda bisa mengubah warna-warna tersebut. 

Jangan lupa untuk memberikan ukuran besarnya stroke pada pilihan size. 



Modul Praktikum Desain Grafis 119  

 

 

 

Gambar 147. Contoh Hulk 

 

f. Untuk memberikan kesan 3 dimensi, anda juga dapat memberikan efek 

Bevel and Emboss serta texture dibawahnya. 

g. Pada kotak element, pattern, klik di sana untuk menampilkan pilihan 

 

texture. Di sini penulis menggunakan tekstur Satin 

 

Gambar 148. Contoh Elemen Pattern 

h. Warnai background-nya dengan warna hitam agar efek yang terjadi 

Nampak kontras. Akhirnya objek yang anda peroleh akan Nampak seperti 

gambar berikut. 
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Gambar 149. Contoh Background 
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MENGOLAH IMAGE VECTOR 

 

Vector merupakan gambar digital yang terdiri dari kombinasi garis dan titik yang 

melalui proses rumus matematika. Software yang terkenal menggunakan satuan file 

Vector adalah Adobe Illustrator, sedangkan Adobe Photoshop sendiri merupakan 

software yang menggunakan satuan bitmap, atau sekumpulan titik-titik (Pixels) yang 

memiliki warna tersendiri. Jadi, meskipun Photoshop tidak bisa menghasilkan gambar 

dengan satuan vector, tapi kita masih tetap bisa membuat Vector Art (Gambar Vektor) 

dengan Photoshop. Umumnya cara membuat Vector Art di Photoshop adalah 

menggunakan Pen Tool, sehingga menghasilkan garis-garis berupa Polygon. Namun 

karena kita membuat vector art di Photoshop, kita bisa beralih menggunakan cara yang 

lain, yang hasilnya mirip atau bahkan sama persis seperti menggunakan Pen Tool.Jadi 

Tool atau fitur apa yang akan digunakan? Silahkan langsung lanjut saja ke langkah-

langkah cara membuat vector art dibawah ini. 

Tutorial Membuat Vector Art di Photoshop: 

1. Persiapkan gambar yang akan di rubah menjadi gambar vektor Pertama 

siapkan terlebih dahulu gambar atau photo yang akan Anda edit atau rubah 

menjadi vektor. Biasanya saya download gambar gratis tanpa copyright berukuran 

HD di pexels atau pixabay. Pastikan juga foto yang akan dirubah menjadui 

vector adalah photo portrait, foto yang menampikan ekspresi dari seseorang, 

umumnya setengah badan atau Close Up ke wajah. 

2. Import / masukkan foto ke Photoshop 

Selanjutnya masukkan foto yang telah Anda miliki ke software Adobe Photoshopnya. 

Buka software Photoshop, kemudian klik Open, lalu pilih foto di direktori 

penyimpanan Anda. Anda juga bisa import foto ke Photoshop dengan cara drag and 

drop. Selanjutnya pastikan foto yang Anda import tersebut memiliki dimensi HD atau 

diatas 1080 Pixels dan berikan Resolution lebih dari atau sama dengan >= 300 
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Pixels/Inch. Caranya pilih menu Image > Image Size, atau tekan tombol shortcut 

kombinasi (Ctrl + Alt + I) pada keyboard, jika sudah kemudian klik OK. 

 

Gambar 150. Import Foto ke Adobe Photoshop  

Pastikan resolusi foto lebih dari 300 pixels dan resolusi HD 

3. Duplikat foto object 

Selanjutnya adalah menduplikasi atau membuat salinan foto baru dari layer 

Background. Caranya adalah klik layer Background, kemudian tekan tombol 

kombinasi (Ctrl + J) pada keyboard. Kemudian akan muncul layer baru dengan nama 

“Layer 1”. Selanjutnya klik ikon mata pada layer “Background” untuk 

menyembunyikan layer tersebut. 

4. Melakukan seleksi pada Object Foto 

Selanjutnya kita akan menyeleksi foto object, Anda bisa bebas menggunakan tool 

seleksi seperti Pen Tool, Lasso Tool, atau yang lainnya. Namun disini saya akan 

menggunakan Quick Selection Tool. 

 

Gambar 151. Seleksi Objek Foto 

Pilih qucik selection tool untuk melakukan seleksi foto object Kemudian lakukan seleksi 

pada bagian objek foto. Selanjutnya duplikat lagi “Layer 1” tersebut dengan menekan 

tombol (Ctrl + J). Selanjutnya klik atau pilih “Layer 1” tersebut, kemudian hapus dengan 

cara menekan tombol (Delete) pada keyboard. 
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5. Menambahkan Background Warna Putih 

Selanjutnya adalah menambahkan background warna putih agar efek dari vector art 

yang kita buat semakin jelas serta background yang memiliki banyak warna tadi tidak 

terpengaruh oleh efek yang akan kita berikan nantinya. Caranya adalah pada Panel 

Layer, klik kanan pada ikon Create a new fill or adjusments layer dengan ikon 

lingkaran hitam putih, kemudian pilih opsi Solid Color. Kemudian akan muncul 

jendela Color Picker (Solid Color). Arahkan atau drag lingkaran pada panel color ke 

warna putih, kemudian klik OK. Dengan Layer “Color Fill 1” terpilih, selanjutnya 

tekan dan tahan tombol (Shift) pada keyboard, kemudian klik “Layer 2”, klik kanan 

pada “Layer 2”, kemudian pilih opsi Merge Layers untuk menggabungkan kedua 

layer tersebut. Untuk shortcut menggabungkan layer, Anda bisa menekan tombol 

kombinasi (Ctrl + E) pada keyboard. 

6. Memberikan Filter ke Object Foto Vector Art 

Selanjutnya kita akan memberikan efek oil paint menggunakan fitur Filter pada 

Photoshop. Pilih “Layer 2”, klik menu Filter > Sharpen > Smart Sharpen. Berikan 

nilai Amount = 250%, Radius 3.5 px, Reduce Noise = 35%, dan dropdown Remove 

rubah menjadi Gaussion Blur. 

 

Gambar 152. Pemberian Filter ke Objek Foto 

Berikan efek smart sharpen pada foto Selanjutnya ke menu Filter > Stylize > 

Diffuse > Anisotropic. 

Kemudian ulangi langkah pemberian filter Smart Sharpen dan Diffuse ini sekali lagi. 

7. Memberikan detail Efek ke Foto Object 

Selanjutnya kita akan memberikan detail pada foto objek. Pemberian efek inilah yang 
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akan memberikan kesan kartun ke foto atau memberikan nuansa style Vector Art. 

Klik kanan pada “Layer 2”, kemudian pilih opsi Convert to smart object, ini berguna 

agar kita bisa mengatur kembali filter detail yang diberikan ke foto tanpa harus 

mempengaruhi layernya. Kemudian duplikat sebanyak 2 kali “Layer 2” tersebut. 

Kemudian rubah nama “Layer 2” menjadi Detail Keras, “Layer 2 copy” menjadi 

Detail Sedang, dan “Layer 2 copy 2” menjadi Detail Halus. Caranya klik 2 kali pada 

nama layer tersebut untuk Rename atau merubah namanya. Anda juga bisa merubah 

namanya sesuai dengan keinginan. 

Memberikan Efek ke Layer Detail Keras 

Selanjutnya klik layer “Detail Keras” kemudian klik ikon mata pada 2 layer 

diatasnya. 

 

Gambar 153. Berikan Efek ke Layer 

Pilih layer detail keras dan hide 2 layer diatasnya Selanjutnya pilih menu Filter > 

Filter Gallery > Artistic Folder > Cutout. 

Berikan nilai Number of Levels = 8, Edge Simplicity = 5, dan nilai Edge Fidelity 

= 1. Jika sudah lalu klik OK. 
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Gambar 154. Pemberian Filter 

Selanjutnya masih di layer Detail Keras, pilih menu Filter > Sharpen > Unsharp 

Mask. 

Berikan Amount = 130%, Radius 2.0 Pixels, Threshold = 0 levels, lalu klik OK. 

 

 

Gambar 155. Unsharp mask
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Memberikan Efek ke Layer Detail Sedang 

Pilih layer Detail Sedang, kemudian klik kotak ikon mata pada layer untuk menampilkan 

layer. Selanjutnya pilih menu Filter > Filter Gallery > Artistic Folder > Cutout. Berikan 

nilai Number of Levels = 8, Edge Simplicity = 6, dan nilai Edge Fidelity = 1. Jika 

sudah lalu klik OK. Kemudian double klik ikon Filter Blending Options pada Layer Detail 

Sedang. Kemudian turunkan Opacity filter tersebut menjadi 40%. 

 

Gambar 156. Efek Layer Detail Sedang 

Klik Ikon Filter Blending Options 

Selanjutnya tambahkan efek cutout lagi, pilih menu Filter > Filter Gallery > Artistic 

Folder > Cutout. Berikan nilai Number of Levels = 8, Edge Simplicity = 6, dan nilai 

Edge Fidelity = 2. Jika sudah lalu klik OK. 

Kemudian turunkan Opacity Filter Gallery yang kedua (paling atas) tersebut menjadi 

40%. Selanjutnya masih di layer Detail Sedang, pilih menu Filter > Sharpen > Unsharp 

Mask. Berikan Amount = 230%, Radius 2.0 Pixels, Threshold = 0 levels, lalu klik OK. 

Lalu turunkan Opacity dari layer Detail Sedang menjadi 40%. 

Memberikan Efek ke Layer Detail Halus 

Selanjutnya klik layer Detail Halus, kemudian munculkan dengan klik ikon mata pada 

layer. 

Selanjutnya pilih menu Filter > Other > High Pass, berikan nilai Radius 2.0 Pixels, 

kemudian klik OK. 
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Gambar 157. Efek Layer Detail Halus 

Kemudian rubah Blend Mode dari layer Detail Halus menjadi Overlay. Rubah blend mode dari 

layer detail halus 

8. Kelompokan layer 

Selanjutnya klik layer Detail Keras, lalu tekan dan tahan tombol Shift pada Keyboard, 

kemudian klik layer Detail Halus agar ketiga layer tersebut terpilih. Kemudian tekan tombol 

(Ctrl + G) pada keyboard untuk mengelompokan layer tersebut. 

9. Menambahkan Adjusment Layer 

Caranya adalah pada Panel Layer, klik kanan pada ikon Create a new fill or adjusments layer 

dengan ikon lingkaran hitam putih, kemudian pilih opsi Levels. 

Selanjutnya sesuaikan anak panah agar foto Anda menjadi lebih enak dipandang. 

Untuk lebih jelas mengetahui tentang fungsi dan penggunaan fitur Levels di Photoshop. 
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Gambar 158. Menambahkan adjusments levels 

Menambahkan Vibrance 

Selanjutnya kita akan menambahkan Vibrance agar warnanya terlihat lebih tegas. 

Caranya hampir sama, klik kanan pada ikon Create a new fill or adjusments layer dengan 

ikon lingkaran hitam putih, kemudian pilih opsi Vibrance. Kemudian atur slider 

Saturation dan Vibrance sesuai dengan yang Anda inginkan. 

Menambahkan Color Balance 

Adjusments yang terakhir adalah Color Balance, seperti namanya fitur adjusment ini 

berfungsi untuk menyeimbangkan warna dari setiap warna. Agar Anda lebih paham, Anda 

bisa membaca artikel fungsi dan penggunaan Color Balance di Photoshop. Kemudian 

kelompokan lagi 3 layer adjusment tersebut. 
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10. Simpan Gambar Vector Art Yang Sudah Selesai 

 

Gambar 159. Hasil Simpan Vector Art 

Terakhir simpan hasil editing ala Vector Art Anda dengan cara menekan tombol 

kombinasi (Ctrl + Alt + Shift + S). Kemudian tentukan tempat menyimpannya, dan klik 

OK. 

 

Edit Foto di Photoshop 

Pembahasan kali ini menjelaskan bagaimana cara mempercantik foto saja. Ini 

dikarenakan inilah tutorial editing foto yang paling banyak dicari orang-orang. 

 

1. Pertama, silakan buka aplikasi Photoshop > Klik File > Pilih Open > Cari foto 

yang diinginkan > Kemudian klik Open. 
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Gambar 160. Tampilan Open Photoshop 

Gambar 161. Tampilan Photoshop Setelah Dibuka 

2. Setelah foto dibuka, klik Quick Selection Tools pada bagian kiri menu. 

3. Selanjutnya, seleksi bagian-bagian foto yang ingin kita percantik nantinya 

(contoh di sini saya seleksi pemandangannya, karena ingin mempercantik tampilan 

latar belakang tersebut). 
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Gambar 162. Contoh Foto Pemandangan 

Catatan: 

Untuk seleksi objek secara cepat bisa juga menggunakan Magic Wand Tool untuk seleksi 

otomatis. 

 

4. Setelah selesai diseleksi, kita lanjut pilih menu Image (ada di bagian atas) 

> Adjustment > Lalu pilih Hue/Saturation. 
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Gambar 163. Seleksi Saturation 

Di sini saya ingin membuat pemandangan jadi hitam-putih. Atur kolom Saturation menjadi 

paling rendah. Seperti pada gambar berikut ini: 

 

 

Gambar 164.Atur Kolom Saturation 

5. Selanjutnya, klik kanan pada foto > Lalu klik Select Inverse > Maka nanti 

hasil seleksinya akan berubah. 
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Gambar 165.    Select Inverse
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6. Buka lagi Image > Adjustment > Hue/Saturation > Lalu atur setting-nya 

sesuai dengan kebutuhan masing-masing. 

 

Gambar 166. Pengaturan Saturation 

 

Sebenarnya nggak harus Hue/Saturation saja, sih. Bisa juga Color Balance, Brightness, 

dan lain-lain. Silakan dicoba saja sendiri. 

 

Hue Memberikan efek warna baru 

 

Saturation 

 

Mengatur saturasi warna 

 

Lightness 

 

Menambah efek terang atau gelap 

 

7. Setelah foto selesai diberi pengaturan saturasi, kita bisa lanjut dengan memberi 

efek tertentu pada foto (biar semakin cantik). Klik kanan pada foto, lalu pilih 

Deselect (untuk menghilangkan seleksi). 
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Gambar 167. Deselect 

8. Lihat pada menu bagian atas > Klik Filter > Render > Lens Flare. 

  Gambar 168. Render Lense Flare 
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9. Atur Brightness Lens Flare sesuai keinginan. Letakkan fokus cahaya di 

bagian pojok, kurang lebih seperti ini: 

Gambar 169. Pengaturan Brightness Lens Flare 

10. Klik OK. Maka foto Anda sekarang sudah berhasil diedit. 

  



Modul Praktikum Desain Grafis 137  

MENGOLAH IMAGE BITMAP 

 

Photoshop memang dikenal sebagai software pengolah gambar bitmap (raster), tapi 

kamu juga bisa nemuin fitur dan trik yang mendukung gambar vektor di sini, lho. Salah 

satu fitur menariknya adalah kemampuan Photoshop mengubah gambar jadi vektor. 

perbedaan utama antara format vektor dan raster adalah gambar vektor itu terdiri dari 

jalur, sehingga kita bisa lebih gampang menskalakan dan ng-edit. Sementara gambar 

raster terdiri dari piksel. Saat kamu akan mengubah ukuran atau menskalakan gambar 

raster, itu akan mempengaruhi kualitas gambar dan membuatnya terlihat nge-blur atau 

berpiksel. Pada gambar vektor kamu nggak akan menemukan masalah itu, karena kamu 

bisa menskalakannya sesuka hati tanpa mempengaruhi kualitas gambar vektor Perbedaan 

Grafis Vektor dan Grafis Bitmap 

Gambar vektor merupakan gambar yang terbentuk bukan dari kumpulan titik melainkan 

terbentuk dari sejumlah garis dan kurva. Karena gambar jenis vektor ini bukan terdiri dari 

titik, maka apabila tampilan gambar ini diperbesar tetap tidak akan kehilangan detailnya 

sehingga kualitas gambarnya tetap baik. Contoh gambar ini adalah teks dan logo. Monitor 

biasanya akan menampilkan gambar dalam bentuk piksel, maka semua gambar baik jenis 

vector maupun bitmap akan ditampilkan dalam bentuk piksel. Gambar ini mengandung 

unsur matematis seperti arah, ukuran sudut, ketebalan, warna, dan lain sebagainya. 

Sedangkan gambar bitmap, tampilan bitmap sering disebut dengan gambar raster yaitu 

tampilan gambar yang terdiri dari titik-titik atau piksel. Masing-masing piksel ini 

mempunyai lokasi serta warna tersendiri yang secara keseluruhan membentuk sebuah 

tampilan gambar pada saat gambar diperbesar. Kehalusan tampilan gambar ini sangat 

tergantung kepada resolusi serta titik atau piksel yang membentuk gambar tersebut. 

Apabila gambar ini diperbesar maka ini kelihatan kotak-kotak, semakin besar tampilan 

gambar maka semakin besar pula kotak-kotak tersebut, 
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yang sebetulnya merupakan tampilan piksel yang diperbesar. Contoh gambar bitmap 

antara lain photo, gambar-gambar hasil scanner serta gambar yang dihasilkan dari 

software grafis seperti Adobe Photoshop, Corel PHOTO-PAINT. 

Kelemahan dari gambar jenis bitmap adalah gambar akan menjadi pecah dan terlihat 

“kotak-kotak” (jagged) apabila gambar tersebut diperbesar atau dicetak menggunakan 

resolusi yang lebih kecil daripada nilai resolusi aslinya. Format bitmap ini memerlukan 

ruang penyimpanan data yang lebih besar dibandingkan dengan format vektor. 

Grafis vektor adalah objek gambar yang dibentuk melalui kombinasi titik-titik dan garis 

dengan menggunakan rumusan matematika tertentu. 

Perbandingan Gambar-Gambar Berbasis Vektor dan Bitmap: Berikut ini terdapat 

beberapa gambar-gambar berbasis vektor dan bitmap, terdiri atas: 

1. Vektor 

Terdiri atas: 

• Tetap utuh pada saat diperbesar 

• Tersusun dari kurva (path). Path terdiri dari garis (line segment) dan beberapa 

titik (node) atau disebut dengan anchor point. 

• Gradasi warna harus dianalisis dulu oleh para desainer grafis. 

• Tidak mengenal resolusi. Kualitas gambar tergantung pada point pembentuk 

path. 

• Menyimpan gambar sesuai dengan software yang kita gunakan misalnya 

CorelDRAW dalam format berekstensi AI dan Macromedia Freehand 

• Nyaman dipakai untuk melayout halaman (teknik publishing), membuat font, 

dan ilustrasi. 

• Ukuran file yang dihasilkan kecil 

• Kualitas grafis tidak bergantung dari banyaknya pixel 
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2. Bitmap Terdiri atas: 

• Pecah saat diperbesar 

• Tersusun oleh selebaran titik-titik (piksel), beragam warna, piksel tersebar 

dalam pola grid. 

• Gradasi warna lebih luwes dan nyata 

• Semakin besar resolusi, semakin tinggi kualitas foto 

• Mampu menyimpan gambar antar-format, yaitu JPEG, BMP, GIF, TIFF dan 

PNG 

• Nyaman dipakai untuk gambar-gambar dengan efek 

bayangan (shading) yang halus 

• Ukuran file yang dihasilkan besar 

• kualitas grafis bergantung dari banyaknya pixel 

 

Kelebihan dan Kelemahan Vektor dan Bitmap: 

Berikut ini terdapat beberapa kelebihan dan kekurangan vektor dan bitmap, terdiri 

atas: 

1. Vektor 

Terdiri atas: 

a) Kelebihan Grafis Vector 

1. Ruang penyimpanan untuk objek gambar lebih efisien. 

2. Gambar vektor Obyek dapat berubah dalam ukuran dan bentuk tanpa 

menurunkan kualitas tampilannya. 

3. Dapat dicetak pada resolusi tertinggi pada printer. 

4. Menggambar dan bentuk mengedit vektor relatif mudah dan menyenangkan. 

b) Kekurangan Grafis Vector 

Tidak dapat menghasilkan objek gambar vektor utama ketika mengkonversi objek 

gambar format bitmap. 
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2. Bitmap 

Terdiri atas: 

a) Kelebihan Grafis Bitmap 

1. Dapat menambahkan efek khusus tertentu sehingga mereka dapat membuat 

objek tampil seperti yang diinginkan. 

2. Dapat menghasilkan objek gambar bitmap gambar vektor objek dengan cara 

yang mudah dan cepat, kualitas hasil dapat ditentukan. 

3. Mampu menangkap nuansa warna alami dan bentuk. 

b) Kekurangan Grafis Bitmap 

Objek memiliki masalah ketika gambar diubah ukurannya, terutama ketika objek 

gambar diperbesar. Efek diidapat dari objek berbasis bitmap yang akan pecah terlihat 

atau rincian kurang bila dicetak pada resolusi yang lebih rendah. 

 

Cara mengubah gambar menjadi vector: 

1. Siapkan Gambar yang Mau Kamu Ubah jadi Vektor 

Gambar 170. Menyisipkan Gambar  

Langkah pertama adalah menyiapkan gambar yang ingin divektorkan. Tekan tombol Ctrl 

+Alt + I pada keyboard untuk membuka jendela Image Size dan atur ukuran gambar di 

resolusi 300. Kemudian pisahkan gambar yang ingin kamu ubah jadi vektor dari 

background. Pilih dan salin di layer baru atau hapus background. 

2. Buatlah Work Path 



Modul Praktikum Desain Grafis 141  

 

 

Gambar 171. Buat Work Path 

Klik ikon layer pada panel Layers sambil menahan tombol Control di keyboard-mu. 

Setelah itu, pilih Marquee Tool pada pallete atau kamu juga bisa menekan tombol M pada 

keyboard. Pindahkan kursor ke seleksi dan klik kanan. Lalu pilih Make Work Path dari 

menu dan atur Tolerance di angka 1.0. 

     

Gambar 172. Pengaturan Tolerance 

3. Buat Vector Mask 

ke tool Direct Selection atau tekan tombol A dan klik kanan sekali lagi pada gambar. 

Kemudian pilih Create Vector Mask. Langkah ini akan membuat vector mask di atas 

layer, seperti yang akan terlihat di panel Layers. 



Modul Praktikum Desain Grafis 142  

4. Export as a Vector File 

 

 

Gambar 173. Export Vector File 

Buka File > Save As lalu pada menu Save As Type, kamu bisa memilih format file 

Photoshop EPS. Dan klik Save untuk menyimpan gambar vektor. 
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